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Inleiding 

Hartelijk dank voor het kiezen van de Noxturnal® toepassingssoftware. De Noxturnal-software is een 

modern slaapdiagnostieksoftwareplatform bedoeld voor gebruiksgemak en een efficiënte bediening. 

De Noxturnal-software is een essentieel onderdeel van de Nox Sleep Assessment Systems (Nox-

slaapbeoordelingssystemen). De belangrijkste functie ervan is het werken met fysiologische signalen 

die worden geregistreerd/ontvangen met behulp van apparaten van Nox Medical (zie het hoofdstuk 

Ondersteunde apparaten) en de eraan gekoppelde apparaten en accessoires. Het neemt de gebruiker 

mee door de werkstroom van het configureren van registraties, het downloaden van gegevens, 

analyseren en rapporteren.  

Beoogd gebruik 

Het Nox-slaapsysteem wordt gebruikt als hulpmiddel voor de diagnose van verschillende 
slaapstoornissen en voor de beoordeling van slaap. 

Het Nox-slaapsysteem wordt gebruikt voor het meten, registreren, weergeven, ordenen, analyseren, 
samenvatten en ophalen van fysiologische parameters tijdens de slaap en het wakker zijn van 
patiënten ouder van 2 jaar en ouder.  

Met het Nox-slaapsysteem kan de gebruiker de complexiteit van het onderzoek bepalen door te 
variëren met het aantal en het type te meten fysiologische signalen. 

Met het Nox-slaapsysteem kunnen gebruikersrapporten/voorgedefinieerde rapporten worden 
gegenereerd op basis van de gegevens van de betrokkene. 

De gebruikers van het Nox-slaapsysteem zijn medische professionals die zijn getraind in ziekenhuis-
/klinische procedures, fysiologische monitoring van mensen of onderzoek naar slaapstoornissen. 

De beoogde omgevingen zijn ziekenhuizen, instellingen, slaapcentra, slaapklinieken en andere 
testomgevingen, waaronder de woonomgeving van de patiënt. 

Contra-indicaties 

Het Nox-slaapsysteem geeft geen alarmen af en is niet bedoeld voor continue monitoring omdat 
storing kan leiden tot letsel of overlijden van de patiënt. 

Reikwijdte 

In deze handleiding wordt het gebruik van de Noxturnal-software beschreven. Het gebruik van de 

Nox-apparaten en de bijbehorende accessoires die nodig zijn voor de registratie van fysiologische 

signalen worden beschreven in: 

• Handleiding Nox A1 

• Handleiding Nox A1s 

• Handleiding Nox C1 

• Handleiding Nox T3 

• Handleiding Nox T3s 

 

Deze handleiding bevat ook een korte inleiding over de Noxturnal-app en haar functies.  
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Waarschuwingen en voorzorgen voor gebruik 

 Waarschuwing: De Nox-slaapbeoordelingssystemen zijn NIET GECERTIFICEERD VOOR GEBRUIK 

VOOR CONTINUE MONITORING omdat storing kan leiden tot letsel of overlijden van de 

patiënt. 

 Waarschuwing: De Nox-slaapbeoordelingssystemen zijn bedoeld als hulpmiddel bij de diagnose 

van slaapstoornissen. De systemen moeten worden gebruikt in combinatie met andere 

methoden voor de beoordeling van klinische tekenen en symptomen. 

 NB: Automatische analyse kan minder nauwkeurig zijn dan analyse uitgevoerd door een 

opgeleide arts. Voordat een diagnose wordt gesteld moet het resultaat van de automatische 

analyse/scoretoekenning altijd handmatig door een opgeleide arts worden geverifieerd. 

 Waarschuwing: Afgeleide signalen die door Noxturnal zijn berekend, met name hartslag en 

ademhalingsfrequentie, op basis van de onderliggende elektrocardiogram (ECG) en 

ademhalingsinspanningssignalen, zijn niet gevalideerd voor patiënten met diafragma-

pacing/frenische-zenuwstimulators. 

 Waarschuwing: De drukkolom in de overzichtsparagraaf over positieve luchtwegdruk (PAP) van 

het PAP-rapport en het Polysomnografie-PAP-rapport (PSG-PAP-rapport) geeft de maskerdruk 

van het desbetreffende apparaat weer en NIET de ingestelde druk van het apparaat. 

 Waarschuwing: De Nox A1-, A1s-, T3- en T3s-recorders mogen onder geen beding op de USB-

poort van de pc worden aangesloten terwijl de patiënt nog op de recorder is aangesloten. Dit 

kan leiden tot een elektrische schok bij de patiënt en tot ernstig letsel. 

 

 Lees deze handleiding voorafgaand aan gebruik zeer goed door, met name de 

met een uitroepteken aangegeven paragrafen. 
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Beschrijving Noxturnal 

De Noxturnal-software werkt met de Nox-registratieapparaten en Nox-toegangspunten. Met de 

software kunnen de apparaten worden geconfigureerd en daarnaast kan het de signalen die worden 

geregistreerd/ontvangen door de Nox-apparaten weergeven, navigeren, organiseren, analyseren, 

rapporteren, archiveren en ophalen. Dit hoofdstuk beschrijft de belangrijkste kenmerken van de 

toepassing en de installatieinstructies. 

Beschrijving Noxturnal-app 

De Noxturnal-app is een Android-applicatie die wordt gebruikt als een mobiele interface voor de Nox 
A1-recorders en de Nox C1-toegangspunten. Met de app kan de gebruiker verschillende taken die al 
bekend zijn in de Noxturnal-software flexibeler en dichter bij de patiënt uitvoeren.  
De app bevat de volgende functies: 

 

• Ambulante registraties configureren 

• Verbinden met onlinekamers die in Noxturnal 
zijn geconfigureerd 

• De signaalkwaliteit beoordelen 

• Een impedantiecontrole uitvoeren 

• Biokalibratie uitvoeren 

• Registraties starten en stoppen 

• De status van onlineregistraties bekijken 
(Recording, Standby, Not Prepared 
(registreren, standby en niet voorbereid))  

 

Scan om de app te downloaden de QR-code hierboven of zoek op "Noxturnal" in de Google Play Store. 

De app draait op mobiele apparaten met Android 4.3 of hoger. 

Ondersteunde apparaten 

Noxturnal ondersteunt de volgende Nox-apparaten en de bijbehorende apparatuur en accessoires: 

• Nox A1-recorder 

• Nox A1s-recorder 

• Nox C1-toegangspunt 

• Nox T3-recorder 

• Nox T3s-recorder 

In deze handleiding wordt de term Nox-recorder gebruikt als verzamelnaam voor de Nox A1-, Nox 

A1s- Nox T3- en de Nox T3s-recorder. 

Verder wordt in deze handleiding de term Nox T3-recorders gebruikt als verzamelnaam voor de Nox 

T3-recorder en de Nox T3s-recorder. De term Nox A1-recorders wordt gebruikt als verzamelnaam 

voor de Nox A1-recorder en de Nox A1s-recorder. 

Installatie van Noxturnal 

Bestudeer voorafgaand aan de installatie van de Noxturnal-software de systeemeisen voor het 

uitvoeren van de softwaretoepassing. 
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Systeemeisen voor Noxturnal 

 

 NB: De gebruikte computer moet in overeenstemming zijn met de 

internationale norm IEC 60950-1 voor de veiligheid van 

informatietechnologieapparatuur. 

 NB: Er wordt aanbevolen om een virusbescherming te installeren op de 

computer waarop Noxturnal wordt uitgevoerd. 

De volgende tabel toont de minimum hardware-eisen voor effectieve installatie en gebruik van de 

software. 

Minimum systeemeisen 

Type hardware Minimum eisen 

Besturingssysteem Windows 8.1 

Processor Op x64 gebaseerde Intel of AMD 

Processorkloksnelheid 1,7 GHz of sneller 

Geheugen 2 GB of meer 

Vrije ruimte op de harde schijf 4 GB of meer 

Grafische resolutie 1024x768 of hoger 

Voor online systeeminstallatie gelden dezelfde minimum systeemeisen als hierboven genoemd. Het 

wordt met klem aanbevolen om voor elk onlinesysteem een andere computer te gebruiken. Voor 

ervaren gebruikers is het echter mogelijk om meer dan één systeem op dezelfde computer uit te 

voeren. 

Het wordt aanbevolen om goede IT-praktijken te implementeren, zoals: 

• Beheer de toegang tot de pc waarop het systeem draait 

• Dwing een wachtwoordbeleid af 

• Houd het besturingssysteem van de pc up-to-date 

• Volg de data voor het einde van de ondersteuning van Microsoft Windows 

• Installeer antivirussoftware 

• Beperk het gebruik van de pc alleen voor klinisch gebruik 

• Back-uplocatie van opnamegegevens - Noxturnal zorgt niet voor back-ups van gegevens 

NB: Bij verbindingen met externe systemen zoals Nox Cloud, GDT of HL7, fungeert Noxturnal als client 

waarbij op de bestaande systeeminstallatie wordt vertrouwt voor beveiliging. 

Installatie-instructies 

• Zorg dat u met beheerdersprivileges bent ingelogd in het systeem. 

• Blader naar een bestand op de installatie-cd of de installatiewebsite met de naam Setup.exe 

en voer het uit. 

• Een wizard wordt geopend die de gebruiker door de installatie leidt. Volg de instructies voor 

het installeren van de toepassing. Als u een upgrade uitvoert vanuit Noxturnal 5.x, draait op 
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de achtergrond een upgradeproces. Het upgraden van de gebruikerstoepassingsinstellingen. 

Voorafgaand aan de upgrade is een kopie van de instellingen opgeslagen in "[My 

Documents]\NoxturnalUpgrade".    

 

 

 

 Neem contact op met uw distributeur voor informatie over de nieuwste 

softwareversie en upgrade-informatie. Ga voor distributeurinformatie naar: 

www.noxmedical.com. 

 Neem voor operationele ondersteuning, in het geval van gebruikersfouten, 

cybersecurity-voorvallen of andere soorten voorvallen, contact op met 

support@noxmedical.com 
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Standaardbediening 

Om de Noxturnal-toepassing uit te voeren, dubbelklikt u op het desktoppictogram of klikt u op het 

pictogram van de toepassing in het Windows-startmenu. Om de toepassing af te sluiten, klikt u op de 

X in de rechterbovenhoek of kiest u Exit (Afsluiten) in het menu File (Bestand). 

Als Noxturnal opstart, wordt de werkruimteomgeving weergegeven. Als u een apparaat hebt 

aangesloten, ziet u het in de afbeelding, anders wordt geen apparaat weergegeven. Voor dit 

document hebben we een Nox T3-recorder aangesloten, zoals in de afbeelding te zien is. 

 

Op de pagina Recording (Registratie) werkt de gebruiker met Nox-apparaten en de gegevens die door 

deze apparaten zijn geregistreerd/ontvangen. Deze pagina leidt de gebruiker door de meest 

algemene taken die in de toepassing kunnen worden uitgevoerd.  Dit zijn: 

• Library (Bibliotheek): Deze optie ziet u in de linkerbovenhoek. Deze optie opent de 

registratiebibliotheek. De bibliotheek bevat een lijst van alle registraties die zijn vastgelegd, 

gedownload of handmatig toegevoegd aan de registratiebibliotheek. Zie voor meer 

informatie de paragraaf De registratiebibliotheek. 

• Configure Device (Apparaat configureren): selecteer deze optie om een nieuwe ambulante 

registratie te starten. Een configuratiewizard leidt de gebruiker door het configuratieproces. 

Zie voor meer informatie de paragraaf Starten van een nieuwe ambulante registratie.. 

• Download Recording (Registratie downloaden): Als een registratieapparaat is aangesloten 

dat een registratie bevat, kan de gebruiker de registratie downloaden en beoordelen. Zie 

voor meer informatie de paragraaf Een ambulante registratie van een Nox-

registratieapparaat downloaden.  

Om een onlineregistratie te configureren, moet een onlinekamer worden voorgeconfigureerd en zal 

deze worden weergegeven op de Registratiepagina en selecteerbaar zijn. Zie voor instructies over het 

configureren van een onlineregistratie de paragraaf Instellen van het Nox-slaapsysteem voor 

onlineregistraties.  



Handleiding Noxturnal 

   

~ 12 ~ 

Een Nox-registratieapparaat op Noxturnal aansluiten 

 

 NB: Hoewel wordt aanbevolen om het registratieapparaat via Eject (Uitwerpen) 

te ontkoppelen kan het ook zonder Eject van de computer worden ontkoppeld. 

Noxturnal wordt gebruikt voor het configureren en downloaden van geregistreerde data van Nox 

registratieapparaten. Om te werken met een registratieapparaat begint u door het aan te sluiten op 

de computer met behulp van een USB-kabel. Noxturnal detecteert automatisch het apparaat en geeft 

informatie weer over het apparaat. Detectie kan 2 tot 4 seconden duren. 

Wanneer Noxturnal het aangesloten apparaat detecteert, wordt de volgende informatie over het 

apparaat weergegeven: recording status (registratiestatus), firmware version (firmwareversie) en 

device name (apparaatnaam).  

De op het registratieapparaat uitgevoerde taken zijn afhankelijk van de status van het apparaat, die 

als volgt kan zijn: 

• Empty (Leeg) - Het apparaat is niet geconfigureerd en bevat geen registraties. Klik op 

Configure Device (Apparaat configureren) om het apparaat te configureren voor een nieuwe 

registratie. Houd er rekening mee dat bestaande registraties van het apparaat worden 

verwijderd als het apparaat wordt geconfigureerd. 

• Ready to Record (Gereed voor registratie) - Het apparaat is geconfigureerd maar bevat geen 

registraties. Vanaf dit punt kan de gebruiker het apparaat ontkoppelen en het 

registratieproces starten. 

• Ready to Download (Gereed voor downloaden) - Het apparaat bevat een registratie die nog 

niet naar de computer is gedownload. Klik op de knop Download Recording (Registratie 

downloaden) om de registratie naar de computer te downloaden. 

• Download Complete (Downloaden voltooid) - Het apparaat bevat een registratie die al is 

gedownload en al aan de registratiebibliotheek is toegevoegd. Op dit punt kan de gebruiker 

klikken op Configure Device (Apparaat configureren) om het apparaat te configureren voor 

een andere registratie of klikken op Download Recording (Registratie downloaden) om de 

registratie opnieuw te downloaden. 

Als u klaar bent met het werken met het apparaat klikt u op de koppeling Eject (Uitwerpen) en 

ontkoppelt u het apparaat van de computer. 

De software van het registratieapparaat upgraden 

 

 NB: Nadat u op de notificatie Upgrade firmware hebt geklikt, moet u het 

registratieapparaat  van de computer ontkoppelen en weer opnieuw aansluiten. 

De upgrade van de firmware van het apparaat vindt dan plaats. 

 NB: Het wordt altijd aanbevolen om de firmware-upgrade uit te voeren, om er 

zeker van te zijn dat de Nox-recorder op de meest recente firmwareversie 

draait. Nieuwe firmwareversies kunnen belangrijke updates bevatten voor het 

functioneren van de recorder.  
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Als een nieuwe versie van de apparaatfirmware beschikbaar is voor het aangesloten apparaat, 

informeert Noxturnal de gebruiker hierover door een tooltip in de vorm van een ballon weer te geven 

naast het apparaat. Dit gebeurt apparaatonafhankelijk en u ziet het type apparaat op deze pagina, 

afhankelijk van welk apparaat u hebt aangesloten. In deze afbeelding hebben we een Nox T3-recorder 

aangesloten. 

 

Kies ervoor om deze melding te negeren en door te gaan met werken of om de apparaatfirmware te 

upgraden. Dit laatste wordt altijd aanbevolen. Om te upgraden, klikt u op de ballon en volgt u de 

instructies die worden gegeven. 

Starten van een nieuwe ambulante registratie. 

Om een registratieapparaat gereed te maken voor een nieuwe registratie start u de Noxturnal-

toepassing en sluit u het apparaat met een usb-kabel aan op de computer. Noxturnal detecteert 

automatisch het apparaat en geeft de gegevens ervan weer op de pagina Recording (Registratie). Klik 

op de knop Configure Device (Apparaat configureren) op de pagina Recording (Registratie). Een 

wizard wordt geopend die de gebruiker begeleidt bij het configuratieproces van het apparaat. 

De configuratiewizard is apparaatafhankelijk. Dit betekent dat de configuratiewizard varieert 

afhankelijk van het type Nox-registratieapparaat dat wordt geconfigureerd. De belangrijkste stappen 

zijn echter altijd hetzelfde: 

1. Configuratie van het apparaat. Waar u het te gebruiken type registratie kiest 

(hulpapparatuur die kan worden aangesloten en te registreren kanalen). 

2. Schedule Recording (Registratie plannen), waar u de tijd en datum kunt selecteren voor het 

opstarten van een registratie of waar een patiënt de registratie zelf kan starten. 

3. Patient Information (Patiëntinformatie), waar u de noodzakelijke patiëntinformatie voor de 

registratie toevoegt. 

Deze handleiding toont de configuratiewizard voor de Nox T3-recorder. De eerste stap is definiëren 

welk registratietype voor de registratie moet worden gebruikt. De registratietypen hebben 

beschrijvende namen die aanduiden voor welke registraties ze worden gebruikt. 
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Zie de paragrafen Registratietypen en Apparaatprofielen voor meer informatie over het aanmaken en 

bewerken van registratietypen en apparaatprofielen. 

   

Als een registratietype wordt ingesteld voor het registreren van gegevens van een Bluetooth-

hulpapparaat, bijv. een pulsoximeter, zult u dat in de configuratiewizard zien. Om een Bluetooth-

hulpapparaat te kunnen gebruiken, moet dit apparaat contact maken met het Nox-

registratieapparaat. Voer de juiste Bluetooth apparaat-pincode/het juiste BDA-nummer (Bluetooth 

Device Address-nummer) in het betreffende veld in de configuratiewizard in.  

Voor sommige apparaten is het nodig om het apparaat aan te sluiten op de gebruikte oximeter. Na 

het invoeren van het BDA-nummer van de oximeter, klikt u op de knop Pair with Oximeter 

(Aansluiten op oximeter) en wacht u op het antwoord. De oximeter moet worden ingeschakeld door 

de knop van de oximeter in te drukken wanneer u deze stap uitvoert. Volg de instructies op het 

scherm op.  

Klik op Next (Volgende) om verder te gaan naar stap twee, waar u de registratietijd plant. 
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• Als de optie Manually Start Recording (Handmatig registratie starten) wordt aangevinkt, is 

de gebruiker verantwoordelijk voor het starten/stoppen van de registratie van het Nox-

registratieapparaat. Dit wordt gedaan door de middelste knop op het apparaat ingedrukt te 

houden tot het scherm op het apparaat aangeeft dat de registratie is gestart. 

• Ga naar de optie Start Recording At: (Registratie starten om:) voor het plannen van een 

specifieke registratietijd. Het apparaat schakelt zichzelf in en begint op de aangegeven tijd 

automatisch met registreren. Als de gebruiker ervoor kiest om langer te registreren dan één 

nacht zal elke registratie bij elke nacht op dezelfde tijd beginnen. 

• Om na een specifieke duur te stoppen met registreren, specificeert u de Duration (Duur) als: 

7 uur, 8 uur, 10 uur of voert u een aangepaste duur in. Als er voor Unspecified (Onbepaald) 

wordt gekozen is de gebruiker verantwoordelijk voor het stoppen van de registratie. Dit 

wordt gedaan door de middelste knop op het apparaat ingedrukt te houden tot het scherm 

op het apparaat aangeeft dat de registratie is gestopt. 

Klik op Next (Volgende) om door te gaan naar de derde stap, het patiëntinformatiedialoogvenster. In 

dit dialoogvenster kan uitgebreide informatie over de patiënt worden ingevoerd. Het enige vereiste 

veld is de patiëntnaam of het patiënt-id.  
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Nadat u de patiënteninformatie hebt ingevoerd, klikt u op Finish (Voltooien) om de configuratie weg 

te schrijven naar het apparaat.  

Als er een registratie op het apparaat staat, wordt de gebruiker gevraagd of hij/zij de registratie van 

het apparaat wil wissen. 
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Ten slotte wordt een bevestigingspagina weergegeven ter bevestiging dat het apparaat is 

geconfigureerd. Voor Nox T3-recorders kunnen de aansluitinstructies worden afgedrukt door te 

klikken op de knop Print Hookup Instructions (Aansluitinstructies afdrukken). Een PDF-document met 

het aansluitdiagram wordt gegenereerd en kan worden afgedrukt. Als er geen aansluitinstructies 

beschikbaar zijn, wordt deze optie niet weergegeven. 

   

Registratietypen 

Noxturnal biedt een reeks registratietypen die beschikbaar zijn voor het configureren van zowel 

ambulante als onlineregistraties. De registratietypen bevatten de apparaatcombinatie die wordt 

gebruikt voor verschillende typen onderzoeken en de apparaatinstellingen. De registratietypen 

definiëren ook de automatisering voor de verschillende registraties, de relevante werkruimtelayout, 

analyse en rapportage die voor de registratie worden gebruikt. In Noxturnal kunt u gemakkelijk uw 

eigen registratietypen aanmaken om apparaten aan te sturen en de voor registraties gebruikte 

instellingen te regelen. Volg deze stappen om uw eigen registratietype aan te maken.  

1. Selecteer het Nox-registratieapparaat waarvoor u het registratietype aanmaakt en geef aan 

of dit is bestemd voor ambulante of onlineregistraties. 

2. Stel een registratietype zo in dat het werkruimtelayout, analyse en rapportage en de te 

gebruiken apparaten en apparaatprofielen bevat, zoals van toepassing. 

De wizard Registratietype is apparaatafhankelijk. Dit betekent dat de wizard varieert afhankelijk van 

het type Nox-registratieapparaat dat wordt geconfigureerd. De belangrijkste stappen zijn echter altijd 

hetzelfde: 
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Navigeer vanuit de Noxturnal-taakbalk naar Devices > Recording Types (Apparaten > 

Registratietypen)…  

 

De wizard Registratietype wordt geopend. 

 

  

Hier kunt u een New (Nieuw) registratietype of een New Based On (Nieuw op basis van) één van de 

beschikbare registratietypen aanmaken en bij eerder zelf aangemaakte registratietypen kiezen voor 

Edit (Bewerken) of Remove (Verwijderen). In dit voorbeeld zullen we een nieuw registratietype 

aanmaken voor de Nox T3-recorder.  

Selecteer het registratietype Nox T3 (ambulatory (ambulant)) uit de hieronder weergegeven 

vervolgkeuzelijst. 
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De volgende stap is het instellen van het registratietype, zoals van toepassing. In de volgende wizard 

kunt u uw registratietype instellen.  
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Voer de Recording Type Name (Registratietypenaam) en de Description (Beschrijving) van het 

registratietype in. Kies de gewenste Workspace Layout (Werkruimtelayout), Analysis (Analyse) en 

Report (Rapportage). U kunt ook hulpapparaten toevoegen. Kies bijvoorbeeld de Nonin 3150 (onder 

Device Types (Apparatuurtypen)) en klik op Add>> (Toevoegen). 

 

Het is ook mogelijk om het toepasselijke apparaatprofiel voor dit registratietype rechtstreeks te 

kiezen in de wizard Registratietype, zie hieronder.  
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U kunt ook aangepaste apparaatprofielen aanmaken. Volg de instructies in de paragraaf 

Apparaatprofielen voor verdere instructies. Zodra u een apparaatprofiel hebt aangemaakt, wordt dit 

weergegeven in de vervolgkeuzelijst in de registratietypewizard. 

Als u uw registratietype hebt ingesteld, klikt u op OK en komt uw aangepaste registratietype 

beschikbaar voor configuratie.  

Apparaatprofielen 

 
 NB: De apparaatprofielenwizards verschillen per Nox-registratieapparaat. 

De apparaatprofielen worden aangemaakt voor alle standaardregistraties die u met Nox-apparaten 

kunt uitvoeren. U kunt ze gebruiken om tijdens het apparaatconfiguratieproces eenvoudige 

installaties uit te voeren. 

Vanuit de Noxturnal-taakbalk navigeert u naar Devices > Device Profiles… (Apparaten > 

Apparaatprofielen...) 
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In de wizard Apparaatprofielen wordt een lijst weergegeven van de beschikbare apparaatprofielen 

voor de Nox-registratieapparaten en het Nox-toegangspunt. 

 

Om een aangepast apparaatprofiel aan te maken, selecteert u New (Nieuw) of New Based On (Nieuw 

op basis van). U moet dan selecteren voor welk registratieapparaat de template is bestemd of op welk 

van de huidige apparaatprofielen u uw nieuwe template wilt baseren. In dit voorbeeld zullen we een 

nieuw apparaatprofiel aanmaken voor de Nox T3-recorder. 
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In de wizard Profieleigenschappen kunt u het apparaatprofiel instellen. Voer de naam in (en 

desgewenst een beschrijving).  

  

Klik op Next (Volgende) om verder te gaan naar de volgende stap. 

In de het onderstaande dialoogvenster kunt u de kanaalconfiguratie voor het apparaat instellen. Het 

dialoogvenster Apparaat configureren is apparaatafhankelijk. Dit betekent dat de wizard varieert 
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afhankelijk van het type Nox-apparaat dat wordt gebruikt. Als u de kanaalconfiguratie hebt ingesteld, 

klikt u op Next (Volgende). 

   

De laatste stap in de configuratie van een Nox-registratieapparaat is het definiëren van het gebruikte 

batterijtype. Selecteer het van toepassing zijnde batterijtype en klik op Finish (Voltooien). 
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Het apparaatprofiel dat u hebt aangemaakt wordt in de lijst met apparaatprofielen weergegeven en is 

beschikbaar voor configuratie.  

Een ambulante registratie van een Nox-registratieapparaat downloaden 

 

 NB: Als het downloaden om de een of andere reden deels mislukt, kan dat 

leiden tot onduidelijke registratieresultaten. De gebruiker zal worden 

gewaarschuwd als dit gebeurt en moet dan beslissen of de geregistreerde 

gegevens al dan niet volledig zijn. Het is mogelijk om de gegevens nogmaals te 

downloaden vanaf het apparaat. 

 NB: De gedownloade registratie wordt pas van het apparaat verwijderd als het 

apparaat  voor een andere registratie wordt geconfigureerd. 

Om geregistreerde gegevens van een Nox-registratieapparaat naar de computer  te downloaden, 

moet u ervoor zorgen dat Noxturnal draait en vervolgens een apparaat op een USB-poort van de 

computer aansluiten. 

Noxturnal detecteert automatisch het apparaat en geeft de informatie ervan weer op de Recording 

Page (Registratiepagina). Detectie kan 2 tot 4 seconden duren. 

Klik op de knop Download Recording (Registratie downloaden) op de Recording Page 

(Registratiepagina) en Noxturnal zal beginnen met het downloaden van de registratie vanaf het 

apparaat naar de computer. Een dialoogvenster met de downloadvoortgang wordt weergegeven. 

Deze toont de downloadstappen tijdens het downloaden. De gegevens worden eerst gedownload en 

vervolgens wordt het standaardanalyseprotocol uitgevoerd en als het apparaat is geconfigureerd voor 

het registreren van audio, dan start de audiodownload.  

  

Na het downloaden wordt de gebruiker op de hoogte gesteld en kan deze beginnen te werken met de 

gehele registratie. 

Het downloaden van registraties vindt altijd plaats naar de standaard gegevensopslaglocatie. Het is 

mogelijk om de standaard gegevensopslaglocatie te wijzigen op het automatiseringstabblad in het 

dialoogvenster met beschikbare tools (Tools → Settings… → General (Tools → Instellingen… → 

Algemeen)). Na het downloaden worden registraties automatisch toegevoegd aan de 

registratiebibliotheek en kunnen ze op elk moment worden bestudeerd door naar de 

registratiebibliotheek te gaan en deze te openen. Zie voor meer informatie de paragraaf De 

registratiebibliotheek.  
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Instellen van het Nox-slaapsysteem voor onlineregistraties 

Netwerkoverzicht onlinesysteem 

Volg onderstaande aanbevolen systeeminstallatie voor een stabiele werking van de online 

functionaliteit voor het Nox-slaapsysteem.  

• Het wordt aanbevolen om voor elk onlinesysteem een andere computer te gebruiken. Het is 

echter mogelijk om meer dan één systeem te draaien op één computer. Zie de paragraaf 

Minimum systeemeisen voor details.  

• Gebruik een apart Local Area Network (LAN) voor elk Nox C1-toegangspunt en een computer 

waar de Noxturnal-software op draait. 

• Gebruik een apart Nox C1-toegangspunt voor elke te gebruiken Nox A1-recorder. 

De onderstaande tabel beschrijft de installatie van de controlekamer waar de computer met 

Nocturnal geïnstalleerd is.  

Controlekamer 

Item Aansluiting 

PC 
Met een netwerkkabel aangesloten op 

hetzelfde netwerk als het Nox C1-toegangspunt. 

Noxturnal Geïnstalleerd op een PC 

De onderstaande tabel beschrijft de installatie van een patiëntkamer waar de patiënt slaapt tijdens 

een slaaponderzoek. 

Patiëntkamer 

Itemnaam Beschrijving Functie Installatie/Aansluiting 

Nox C1-
toegangspunt 

Bluetooth-toegangspunt 
met analoge en seriële 
inputs en ingebouwde 
lichtsensor en differentiële 
druksensor. 

 Gegevensoverdracht 
ontvangen van Nox 
A1 via een 
Bluetooth-
verbinding en via 
ethernet naar 
Noxturnal 
doorgestuurd. 

 Opdrachten 
ontvangen van 
Noxturnal via 
ethernet en door 
middel van een 
Bluetooth-
verbinding naar Nox 
A1 doorgestuurd. 

 Gegevensoverdracht 
ontvangen van 
hulpapparaten 
verbonden met 
analoge en/of 
seriële inputs en via 

Die zich in de 
patiëntkamer 
bevinden. 
Aangesloten op 
hetzelfde LAN als de 
pc waarop de 
Noxturnal-software 
draait. 



Handleiding Noxturnal 

   

~ 27 ~ 

ethernet naar 
Noxturnal 
doorgestuurd. 

Nox A1-
recorders en 
de van 
toepassing 
zijnde 
sensoren 

Registratieapparaat dat voor 
verschillende typen 
slaaponderzoeken kan 
worden geconfigureerd. 

Registreert fysiologische 
signalen van 
ingebouwde en 
aangebrachte sensoren. 

Aangesloten op de 
patiënt in de 
patiëntkamer. 

Medische 
hulpapparaten 

Elk medisch hulpapparaat 
dat overeenkomt met de 
inputkanaalspecificaties van 
het Nox C1-toegangspunt. 
Medische hulpapparaten die 
worden ondersteund door 
het systeem voor verbinding 
met de Nox A1-recorders via 
Bluetooth-koppeling 

Afhankelijk van het 
gebruikte hulpapparaat 

De van toepassing 
zijnde aansluitkabel 
aangesloten op de 
analoge/seriële/USB-
input op het Nox C1-
toegangspunt. Via 
Bluetooth-koppeling 
naar de Nox A1-
recorders 

Noxturnal-app Android-app  

Kan worden gebruikt 
voor het verbinden met 
onlinekamers, het 
beoordelen van signalen 
en het uitvoeren van 
biokalibratie en 
impedantiecontrole. 
Kan ook voor het 
starten en stoppen van 
registraties worden 
gebruikt. 

De app instellen op 
onlindemodus en 
verbinding maken met 
de betreffende 
onlinekamer 

De afbeelding hieronder toont een overzicht van de online-installatie van het Nox-slaapsysteem.  

  

Het Nox C1-toegangspunt wordt bestuurd door de Noxturnal-software.  
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Voor verdere instructies over het Nox C1-toegangspunt en de Nox A1-recorders, zie de Nox C1-

handleiding en de Nox A1/A1s-handleiding.  

Zie de paragraaf "Compatibele apparaten" voor de typen ethernetapparatuur en -schakelaars die 

goedgekeurd zijn voor het Nox-slaapsysteem. 

Onlinesysteemconfiguratie 

In dit hoofdstuk wordt het instellen van het Nox-slaapsyteem voor onlineconfiguratie beschreven. 

Overtuig u er eerst van dat u alle benodigde apparaten en accessoires hebt geïnstalleerd, zoals het 

Nox C1-toegangspunt, ethernetkabels en dergelijke. Zie  de handleiding van de Nox C1 voor meer 

informatie over de installatie van uw netwerk, waaronder het Nox C1-toegangspunt.  

Voor het instellen van het Nox-slaapsysteem voor onlineregistratie moet u de volgende stappen, waar 

toepasbaar, uitvoeren: 

1. Instellen onlinekamers 

2. Configuratie nieuwe sensoren 

3. Instellen apparaatprofielen 

4. Instellen registratietypen 

Deze stappen worden hieronder genoemd. Door deze stappen te volgen, kunt u beginnen met uw 

onlineregistratie en vervolgens beginnen met het werken met de signalen in Noxturnal. 

Onlinekamer 

Het installeren van een Onlinekamer is onderdeel van de installatie van Noxturnal voor 

onlineregistraties. De Onlinekamer betreft verzameling van benodigdheden die u normaal gesproken 

in een kamer bij elkaar houdt. Dit kunnen bijvoorbeeld alle apparaten zijn die u in een 

ziekenhuiskamer bij de hand hebt en die speciaal bestemd zijn voor slaaponderzoeken.  

Om een nieuwe kamer toe te voegen, selecteert u Devices > Online Rooms… (Apparaten > 

Onlinekamers…) in de Noxturnal-taakbalk. Het dialoogvenster Rooms (Kamers) verschijnt dan. 
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Van hieruit kunt u een nieuwe kamer toevoegen of een bestaande bewerken. Om een nieuwe kamer 

toe te voegen, klikt u op Add Room (Kamer toevoegen) en in het onderstaande dialoogvenster kunt u 

de nieuwe kamer een naam geven door te klikken op het potloodpictogram en apparaten toevoegen 

aan uw kamer door te klikken op Add Devices (Apparaten toevoegen). 

 

 

In de wizard Apparaten toevoegen kunt u apparaten aan uw kamer toevoegen. Om een apparaat toe 

te voegen, selecteert u het betreffende apparaat in de lijst Device Types (Apparaattypen) en klikt u op 

Add>> (Toevoegen>>) of dubbelklikt u op het apparaat vanuit de lijst. U kunt scannen op aangesloten 

IP-apparaten op uw netwerk door te klikken op Scan for IP Devices (Scan op IP-apparaten). 
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Als u een Nox A1-recorder toevoegt, moet u het van toepassing zijnde Nox C1-toegangspunt 

selecteren dat in de kamer wordt gebruikt en klikken op Scan voor uw Nox A1-recorder of handmatig 

het serienummer van de A1 invoeren. Vergeet niet om voor deze stap uw A1-recorder in te schakelen. 

Selecteer uw recorder uit de lijst en klik op Next (Volgende).  

 

Als u een selectie van apparaten hebt toegevoegd aan de verzameling van beschikbare apparaten, 

kunt u de apparaten selecteren die u wilt toevoegen aan uw Onlinekamer.  
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Om apparaten te selecteren om toe te voegen aan uw kamer, klikt u op het apparaat en er verschijnt 

een blauw kader rond elk geselecteerd apparaat. Als u de apparaten hebt geselecteerd voor 

toevoeging aan de kamer, klikt u op Add to Room (Aan kamer toevoegen), waarna uw kamer met 

deze selectie van apparaten wordt uitgebreid. 

 

 



Handleiding Noxturnal 

   

~ 32 ~ 

Nu hebt u de configuratie van de onlinekamer voltooid. Als u nog meer kamers wilt toevoegen voert u 

bovenstaande stappen nogmaals uit.  

Configuratie van nieuwe sensoren 

Als u nieuwe sensorconfiguraties wilt aanmaken, bijvoorbeeld voor gebruik met het Nox C1-

toegangspunt, kunt u dat doen door te navigeren naar Devices > Sensors… (Apparaten> Sensoren…) 

vanuit de Noxturnal-taakbalk. 

   

Vanuit de wizard Sensoren beheren kunt u een nieuwe sensor aanmaken en bestaande sensoren 

bewerken/verwijderen. Om een nieuwe patiëntsensor of hulpapparaatsensor aan te maken, klikt u op 

New (Nieuw). Patiëntsensoren zijn sensoren die zijn verbonden met de Nox A1-, T3, of T3s-recorders 

en de patiënt. Hulpapparaatsensoren zijn verbonden met het Nox C1-toegangspunt en een 

hulpapparaat.  

 

U kunt selecteren of een nieuwe patiëntsensor of een hulpapparaatsensor moet worden aangemaakt. 

Vul de van toepassing zijnde velden in en klik op OK om de sensorconfiguratie op te slaan. 
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Apparaatprofielen voor onlineapparaten 

U kunt apparaatprofielen instellen voor de Nox-apparaten die voor onlineregistraties worden 

gebruikt. De apparaatprofielen bevatten de kanaalconfiguratie van het apparaat. Noxturnal biedt een 

reeks standaard apparaatprofielen aan en u kunt ook gemakkelijk nieuwe apparaatprofielen instellen. 

Zie voor instructies over het zelf aanmaken van apparaatprofielen de paragraaf Apparaatprofielen 

Registratietypen voor onlineapparaten 

De laatste stap is het instellen van registratietypen. Dit is een lijst van de typen registraties die u 

online zult registreren in uw kliniek. Elk registratietype is een verzameling beschikbare online-

apparaattypen die samen worden gegroepeerd. Bijvoorbeeld: De Standaard PSG met Nox C1 is een 

verzameling van een Nox C1-toegangspunt, een Nox A1-recorder, een Nonin 3150-oximeter en een 

videocamera. Zie voor instructies over het instellen van een nieuw registratietype de paragraaf 

Registratietypen 

Starten van een onlineregistratie 

Als u de bovenstaande stappen voor het instellen van uw onlineconfiguratie hebt voltooid, kan een 

onlineregistratie worden gestart. Vanuit de registratiepagina kunt u een onlineregistratie starten 

binnen de kamer die u hebt ingesteld. Om de registratie te starten, dubbelklikt u op het 

kamerpictogram of klikt u op Configure Recording (Registratie configureren). 

 

Hierdoor wordt de wizard Onlineregistratie starten weergegeven. Met deze wizard kunt u: 

• Selecteer in de vervolgkeuzelijst het registratietype dat zal worden uitgevoerd. 

• De selectie van Apparaten is afhankelijk van het geselecteerde Registratietype. Alle 

apparaten die beschikbaar zijn in de onlinekamer worden genoemd, maar de apparaten 

die geen deel uitmaken van het registratietype zijn grijs gemaakt. U kunt de 



Handleiding Noxturnal 

   

~ 34 ~ 

uitgeschakelde apparaten in de registratie opnemen door het aanvinken van de 

desbetreffende hokjes in de lijst van apparaten. 

• Selecteer Device Profile (Apparaatprofiel) voor een aantal apparaten, zoals de Nox A1 en 

de Nox C1. 

 

Als u uw registratietype en de juiste apparaten samen met hun apparaatprofielen hebt geselecteerd, 

kunt u op Next (Volgende) klikken om naar de patiëntinformatie te gaan. De laatste stap is het starten 

van de registratie en dat doet u door te klikken op Start Recording (Registratie starten) of op Standby 

binnen de wizard Patiëntinformatie.  

Registratie starten: 

Vervolgens ziet u uw geselecteerde werkruimtelayout, waarbij een statusvenster de status toont van 

de registratie die aan het starten is. Ten slotte ziet u in realtime de geregistreerde signalen 

verschijnen en kunt u ermee beginnen te werken. 

Standby-modus: 

De standby-modus opent uw geselecteerde werkruimte met een statusvenster dat toont dat u in de 

standby-modus bent. Hier kunt u verbinding maken met de onlinekamer voor het voorbereiden, 

evalueren en assisteren bij het aansluiten van de patiënt en vervolgens het starten van de registratie 

met behulp van de Noxturnal-app of Start Recording (Registratie starten) zoals beschreven in de 

voorgaande stap. 
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Wanneer de gebruiker de Noxturnal-app heeft verbonden met de onlinekamer, worden de live-

signalen die verschijnen NIET in de registratie opgeslagen. Dit is alleen een preview, zoals ook door de 

preview-status wordt aangegeven. Het signaal wordt geregistreerd wanneer de gebruiker op Start 

Recording (Registratie starten) tikt/klikt in de Noxturnal-app of in de Noxturnal-software. 

 

Door te klikken op de rode REC-knop bovenin in het scherm, kan de gebruiker ook op elk moment na 

de start van de registratie naar de standby-modus gaan als hij de registratie gedurende een bepaalde 

periode wil pauzeren. 

 

Door op de REC-knop te klikken, krijgt u de optie om naar standby-modus te gaan, de registratie te 

stoppen of te annuleren en door te gaan met de registratie. 
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Nox C1-configuratie 

Het Nox C1-toegangspunt is voorzien van 12 analoge kanalen die geschikt zijn voor het opvangen van 

DC-signalen van hulpapparaten. De kanalen worden opgevangen op 6 poorten, gelabeld DC IN 1 tot 

en met 12 bovenop het apparaat. Elke analoge poort is geschikt voor 2 kanalen. Hulpapparaten 

kunnen worden aangesloten op de analoge ingangen van de Nox C1. Het voltagebereik maakt 

communicatiesignalen van -5 V tot +5 V  mogelijk. Zie de handleiding van de Nox C1 voor meer 

informatie over het Nox C1-toegangspunt.  

Netwerkconfiguratie van het Nox C1-toegangspunt 

De standaard fabrieksconfiguratie van het Nox C1-toegangspunt wordt in de onderstaande tabel  

weergegeven. De Nox C1-netwerkconfiguratie kan met Noxturnal worden beheerd. 

Nox C1-netwerkconfiguratie Gegevens 

DHCP-server DHCP-pool: 192.168.101.64 - 192.168.101.127 

Statisch IP-adres 192.168.101.10 

Universele Plug and Play (UPnP) 

ontdekking 

Netwerkprotocol dat mogelijk maakt dat de Nox C1 op een 

netwerk wordt gedetecteerd  

Om de netwerkconfiguratie van de Nox C1 te beheren, kunt u een geconfigureerde onlinekamer 

openen (Devices > Online Rooms… (Apparaten > Onlinekamers)), de Nox C1 selecteren binnen de 

kamer en vervolgens op Edit Device (Apparaat bewerken) klikken. In het onderstaande dialoogvenster 

kunt u zien hoe u de netwerkconfiguratie van de Nox C1 kunt wijzigen.  

 



Handleiding Noxturnal 

   

~ 37 ~ 

Firmware van het Nox C1-toegangspunt upgraden 

Als er een nieuwe versie van de firmware van het Nox C1-toegangspunt beschikbaar is voor het 

verbonden apparaat, laat Noxturnal dit de gebruiker weten door een melding hierover weer te geven 

wanneer de gebruiker een onlineregistratie start. 

 

 

De gebruiker kan via het tabblad Devices (Apparaten) in de menubalk toegang krijgen tot de de 

firmware-upgrade. 

Devices >> Online Rooms… (Apparaten >> Onlinekamers...)  

 

Selecteer het Nox C1-toegangspunt en klik op Edit Device (Apparaat bewerken). 
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Selecteer in het venster met de eigenschappen van het apparaat Upgrade Firmware (Firmware 

upgraden). 

 

 

De voortgang van de firmware-upgrade wordt met een statusbalk weergegeven. Wanneer de upgrade 

klaar is, ziet u dit: 
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Activeren van de Nox DC-kanaallicentie 

Standaard zijn de DC-kanalen op het Nox C1-toegangspunt vergrendeld. Om de DC-kanalen te kunnen 

gebruiken op de Nox C1 heeft u een geactiveerde Nox DC-kanaallicentie nodig. Raadpleeg voor meer 

informatie hierover Nox Medical of diens vertegenwoordigers. 

De licentie wordt geactiveerd door op Set License (Licentie instellen) in het dialoogvenster Device 

Properties (Apparaateigenschappen) te klikken dat hieronder wordt weergegeven, en de instructies 

op de pagina te volgen. 

 

Integratie van videoapparaten voor onlineregistraties 

Noxturnal ondersteunt onlinevideoregistratie. Om de door Noxturnal geboden digitale video-

ondersteuning te gebruiken bij een onlineregistratie moet u uw systeem zodanig configureren dat er 

een videosysteem in kan worden opgenomen. 

Een videoapparaat kan aan uw onlinesysteemconfiguratie worden toegevoegd en de installatie kan 

voor toekomstig gebruik worden opgeslagen. Om een videoapparaat te configureren met uw 

systeem, moet u: 

1. zorgen dat er video-codecs op uw computer zijn geïnstalleerd 

2. zorgen dat het videoapparaat is aangesloten op hetzelfde netwerk als het Nox C1-

toegangspunt en de computer waarop Noxturnal draait  

3. Een onlinekamer inclusief het videoapparaat instellen 

4. Een registratietype instellen, inclusief het videoapparaat en het videoprofiel definiëren  

5. De onlinekamer selecteren en een onlineregistratie starten vanuit de Noxturnal-

registratiepagina 

Een onlinekamer met een videoapparaat installeren 

VIDEO-CODECS 



Handleiding Noxturnal 

   

~ 40 ~ 

Noxturnal's ondersteuning voor video is gebaseerd op de video-codecs die op uw computersysteem 

zijn geïnstalleerd. Deze video-codecs bestaan uit gespecialiseerde software die de compressie en 

decompressie van digitale video mogelijk maakt. Noxturnal installeert geen codecs, maar op de 

meeste computersystemen is een type codecs geïnstalleerd. Voor het gebruiken van video met uw 

Nox-slaapsysteem moeten er codecs op uw computersysteem zijn geïnstalleerd. Noxturnal geeft u 

dan toegang tot de functies die door deze codecs worden ondersteunt. U kunt het K-Lite Codec-

pakket downloaden van de Nox Medical ondersteuningssite: http://support.noxmedical.com/hc/en-

us/articles/207882176  

INTEGRATIE VAN EEN VIDEOCAMERA 

Voor het installeren van een onlineregistratie inclusief een videoapparaat volgt u de onderstaande 

stappen. 

1. Instellen van een onlinekamer in Noxturnal, zoals uitgelegd in de paragraaf Onlinekamer 

(Devices > Online Rooms… (Apparaten > Onlinekamers...) op de Noxturnal-taakbalk).  

2. Voeg een videoapparaat toe aan uw onlinekamer door te klikken op Add Devices (Apparaten 

toevoegen) en Video Device (Videoapparaat) te kiezen in de lijst Device Types 

(Apparaattypen).  

 

3. U ziet het dialoogvenster met de apparaateigenschappen zoals hieronder weergegeven. Klik 

op de betreffende optie, afhankelijk van het gebruikte videoapparaat en klik op Next 

(Volgende). 

http://support.noxmedical.com/hc/en-us/articles/207882176
http://support.noxmedical.com/hc/en-us/articles/207882176
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Voor het instellen van uw IP-camera klikt u op Find...  (Zoeken). Noxturnal scant dan uw netwerk en 

ontdekt videocamera's die zijn aangesloten op uw netwerk, mits UPnP (netwerkprotocol waarmee een 

IP-camera kan worden ontdekt op een netwerk) erop is ingeschakeld. Noxturnal biedt standaard 

verbindingsopties voor sommige IP-camera's (Axis, D-Link-camera's, Vivotek en Hikvision). Zorg ervoor 

dat bij het kiezen van de verbindingsreeks die beschikbaar is in Noxturnal, de verbindingsreeks (URL) 

wordt gekozen die in overeenstemming is met de registratie die u uitvoert: of alleen de video moet 

worden geregistreerd of zowel de video als audio moet worden geregistreerd.  

Als uw camera niet automatisch door Noxturnal wordt gedetecteerd als u Find… (Zoeken...) gebruikt, 

dan kunt u altijd uw camera handmatig toevoegen door de betreffende verbindingsreeks (URL) en het 

IP-adres van de camera in te voeren in het veld File or URL (Bestand of URL).   
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Als u een videoapparaat hebt dat niet door de bovenstaande standaard verbindingsopties wordt 

ondersteund, kunt u altijd handmatig nieuwe verbindingsreeksen (URLs) aanmaken om ze zo voor 

gebruik in de toekomst toegankelijk te maken in Noxturnal. Om dat te doen, bladert u naar Tools > 

Settings > Advanced (Tools > Instellingen > Geavanceerd) en selecteert u de Default Settings 

(Standaardinstellingen). Open de map Video Profiles (Videoprofielen) en open het Excel-werkblad 

IPCameras (IP-camera's). U kunt aan de bestaande lijst van verbindingsreeksen een nieuwe 

verbindingsreeks toevoegen voor uw videoapparaat, die vervolgens beschikbaar wordt voor gebruik 

binnen Noxturnal.  

Als u de gebruikers- en wachtwoordinformatie voor uw camera hebt ingevoerd, kunt u klikken op 

Start Preview (Preview starten) om te bekijken of uw camera correct is geïnstalleerd en werkt met 

Noxturnal. Als een vertraging wordt waargenomen tijdens de preview, kan een vertragingsinput 

worden toegevoegd om het opnieuw afspelen van de video tijdens de analyse te corrigeren. Klik op 

Next (Volgende) om de camera een unieke naam te geven; klik vervolgens op Finish (Voltooien).  

 

Nu hebt u het videoapparaat aan uw onlinekamer toegevoegd.  

Een registratietype met een videoapparaat instellen 

Noxturnal voorziet in standaard registratietypen voor onlineregistraties inclusief een videoapparaat. U 

kunt een van de standaard registratietypen selecteren en direct starten met een onlineregistratie 

inclusief een videoapparaat. U kunt ook een aangepast registratietype instellen en het Windows 

Mediaprofiel definiëren voor gebruik met Noxturnal bij registratie en compressie van de onlinevideo. 

Om dat te doen, navigeert u naar Devices > Recording Types... (Apparaten > Registratietypen…) 

vanuit de Noxturnal-taakbalk. In de wizard Registratietypen selecteert u New (Nieuw) en Online  in de 

vervolgkeuzelijst Recording Type (Registratietype). 
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In de wizard Onlineregistratietype kunt u zowel uw videoapparaat als andere apparaten toevoegen. U 

kunt het videoprofiel dat u wilt gebruiken selecteren in de vervolgkeuzelijst, zie de afbeelding 

hieronder.  

 

Noxturnal biedt een aantal standaard videoprofielen, maar u kunt ook aangepaste profielen 

aanmaken en gebruiken in Noxturnal. Zie voor verdere informatie en instructies over hoe u dat moet 

doen de Nox Medical ondersteuningssite, Windows Media Profiles in Noxturnal. 
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Nu hebt u uw onlinesysteem zo geconfigureerd dat een videoapparaat er deel van uitmaakt en u kunt 

een onlineregistratie starten vanuit de Noxturnal-pagina Recording (Registratie) door te 

dubbelklikken op de kamer, of te klikken op Configure Recording (Registratie configureren).   
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Werken met registraties in Noxturnal 

Registratieresultatenpagina 

Na het downloaden vanaf een registratieapparaat of het openen van een bestaande registratie in 

Noxturnal, wordt de pagina Recording Results (Registratieresultaten) weergegeven. Deze pagina 

bevat een overzicht van de meest algemene analyseparameters en de geregistreerde signalen. De 

resultaatpagina wordt automatisch geüpdatet wanneer veranderingen worden doorgevoerd in de 

bestaande scoretoekenning of als de automatische analyse wordt uitgevoerd. Wanneer slaapstadia 

beschikbaar zijn, zoals voor registraties uitgevoerd met de Nox A1-recorders, dan ziet u grafieken en 

gegevens bij die informatie. Voor de Nox T3-recorders ziet u alleen parameters die beschikbaar zijn bij 

die apparaten. 

 

Commando's resultatenpagina 

De registratieresultatenpagina heeft knoppen voor de volgende acties: 

• View Report (Rapport bekijken): deze optie maakt het standaardrapport voor de registratie 

aan, het rapport dat gedefinieerd is binnen het Registratietypen (zie voor meer informatie de 

paragraaf Registratietypen). 

• Print Report (Rapport afdrukken): deze optie drukt het standaardrapport af. 

• Recording Status (Registratiestatus): deze optie maakt het instellen van de status van 

registraties mogelijk. Gedownloade registraties hebben altijd de status New (Nieuw). Als een 

registratie om de een of andere reden is mislukt, kan de status worden ingesteld op Invalid 

(Ongeldig). Als de registratie is gediagnosticeerd, kan de status worden ingesteld op Scored 

(Gescoord). Als de registratie en de scoretoekenning zijn beoordeeld, kan de status worden 

ingesteld op Reviewed (Beoordeeld). Als de registratie is geïnterpreteerd, kan de status 

worden ingesteld op Interpreted (Geïnterpreteerd). Als een registratie is gediagnosticeerd en 

geaccepteerd, kan de status worden ingesteld op Done (Gereed). 
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Patiëntinformatie 

Het paneel Information (Informatie) toont informatie over de geregistreerde patiënt. Bewerk de 
registratie-eigenschappen en de patiëntinformatie door op het patiëntpictogram te klikken of door te 
drukken op de sneltoets Ctrl+I. 

 

 

Slaapparameters 

Het paneel Sleep Parameters (Slaapparameters) toont een ringdiagram met verschillende slaapstadia 
als de slaapstadia-voorvallen van een score zijn voorzien. 

 

 

• Total Sleep Time (Totale slaapduur) is de tijd die de patiënt heeft geslapen (gebaseerd op 

Hypnogram). 

• Wanneer Total Sleep Time (Totale slaapduur) niet beschikbaar is, wordt de Est. Total Sleep 

Time (Geschatte totale slaapduur) (idem aan de AASM-term Monitoringsduur) de gebruikte 

parameter. Dat is de tijd die de patiënt liggend doorbrengt tijdens de registratie. 

• De slaapefficiëntie varieert van 0 tot 100%, waarbij 0% betekent dat de patiënt de gehele 

nacht wakker was en 100% betekent dat hij gedurende de gehele nacht heeft geslapen. Als 

slaapscoretoekenning niet beschikbaar is, gebruikt de software bewegingsperioden om deze 

parameter in te schatten. 

Ademhalingsindices 

Het paneel Respiratory Indices (Ademhalingsindices) toont de belangrijkste analyseparameters en 

hun relatie tot de ernst. De AHI, de Apnea Hypopnea Index (Apneu-hypopneu-index), is het aantal 

apneus en hypopneus per uur slaap en de Oxygen Desaturation Index (ODI (Zuurstofdesaturatie-

index)) is het aantal gescoorde zuurstofsaturatiedalingen per uur slaap (standaard automatische 

analyse scoort alle desaturaties van 3% of hoger maar dit kan door de gebruiker worden aangepast). 

De ernst gaat van Normaal → Mild → Matig → Ernstig en is in overeenstemming met de door de 
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AASM vastgestelde niveaus. Als meer dan één nacht is geregistreerd, tonen deze parameters de 

gemiddelde waarden voor alle nachten. Zie voor meer informatie de paragraaf Analyseprotocollen. 

 

Totale signaalkwaliteit en Single Body Source (enkele lichaamsbron) 

De OverallSignal Quality (Totale signaalkwaliteit) wordt bepaald aan de hand van de monitoring van 
de signaalkwaliteit van de volgende signalen: oximeter, luchtstroom, buik- of thoracale 
ademhalingsinspanningssignalen. De laagste signaalkwaliteit van die signalen wordt weergegeven 
voor de totale Signaalkwaliteit op de registratieresultatenpagina en heeft een waarde van 0 tot 
100%.  

Het resultaat Single Body Source (Enkele lichaamsbron) geeft aan of de signalen van de oximeter en 

de RIP-band van dezelfde persoon komen. Zie voor meer informatie over dit resultaat de paragraaf 

Single Body Source (enkele lichaamsbron). 

 

Signaaloverzicht en parameters 

Het paneel Signal Overview (Signaaloverzicht) is een top-down-beoordelingstool waarmee 

registratieresultaten op een efficiënte manier kunnen worden beoordeeld en bewerkt. Het 

overzichtspaneel wordt opgesplitst in analyseparameters rechts en het signaaloverzicht links. 

 

De analyseparameters tonen een samenvatting van de meest voorkomende analyseparameters voor 

één nacht. Als meer dan één nacht is geregistreerd, dan wordt elke nacht gerepresenteerd binnen zijn 

eigen panel. U kunt ook de te bekijken periode selecteren met het periodemenu in de 
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rechterbenedenhoek van de toepassing. Elke parameter is van een kleurcode voorzien op basis van de 

mate van ernst, variërend van groen tot rood (Normaal → Mild → Matig → Ernstig). 

• Arousal Index (Arousal-index) is het aantal arousals per uur tijdens de slaap. 

• Sleep Latency (Slaaplatentie) is de duur in minuten van de analysestarttijd tot de eerste 

periode van gescoorde slaap. 

• REM Latency (REM-latentie) is de duur in minuten van het eerste optreden van slaap tot het 

eerste optreden van REM. 

• De ademhaling wordt door indices weergegeven. Indices zijn een methode om 

analyseparameters op een gestandaardiseerde manier weer te geven. 

o Apnea Hypopnea Index (AHI (apneu-hypopneu-index)) 

o Apnea Index (AI (apneu-index)) 

o Hypopnea Index (HI (hypopneu-index)) 

o De Oxygen Desaturation Index (ODI (Zuurstofdesaturatie-index)) stelt het aantal 

zuurstofdesaturatievoorvallen per uur voor van de Total Sleep Time (Totale 

slaapduur) of anders de Est. Total Sleep Time (geschatte totale slaapduur). 

o Het Snore Percentage (Snurkpercentage) is het percentage slaaptijd doorgebracht 

in snurkepisodes (gemarkeerd als Snore-trains) 

o Average dB (Gemiddelde dB) zijn de gemiddelde dB-niveaus tijdens snurkepisodes. 

• De Signal Quality (Signaalkwaliteit) wordt bepaald aan de hand van de monitoring van de 

signaalkwaliteit van de volgende signalen: SpO2, luchtstroom, buik- of thoracale 

ademhalingsinspanningssignalen. De signaalkwaliteit van die signalen wordt weergegeven 

van 0-100%. 

Signalen en voorvallen 

De signalen en voorvallen geplot in het signaaloverzichtpanel geven een overzicht van de gehele 

nacht. 

• Tot de signalen in het overzicht kunnen de volgende behoren: 

o Spectrogram voor het kanaal dat op het scherm wordt weergegeven (Rechtsklikken 

op het spectrogram om het kanaal te veranderen)  

o Sleep Stages/Hypnogram (Slaapstadia/hypnogram) toont de slaapstadia gedurende 

de nacht 

o Arousals toont de arousals gedurende de nacht  

o Beweging 

o Position (Positie) 

o Apneus/RIP-fase (fase tussen buik- en thoracale ademhalingsinspanningssignalen) 

o Zuurstofdesaturatie (SpO2) 

o Pols 

o Audiovolume (Snurk-dB)  

o Beenbewegingen (optioneel) 

• De in het overzicht getoonde voorvallen zijn apneus en hypopneus, 
zuurstofsaturatiedalingen, snurkepisodes en artifacten.  
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De analyseperioden wijzigen 

Als een registratie start voordat alle sensoren zijn bevestigd of als de patiënt de sensoren verwijdert 

voordat de registratie is geëindigd, is het mogelijk om het interval dat wordt geanalyseerd aan te 

passen door de analysestartmarker en de analysestopmarker  te verplaatsen naar de 

betreffende plaats binnen de registratie. Alle analyseparameters worden dienovereenkomstig 

geupdatet wanneer deze aanpassingen worden gedaan. 

 

Gebruik de synchronisatiemarker om in de registratie te navigeren.  Alle signaalbladen zoals de 

bladen PSG, Respiratory (Ademhaling) en Pulse Oximeter (Pulsoximeter) worden dienovereenkomstig 

gesynchroniseerd. Als een interessant voorval te zien is in het overzicht, sleept u de 

synchronisatiemarker over dat gebied en bladert u in het desbetreffende signaalblad om de ruwe 

signalen te bekijken.  

Voorvalperioden kunnen direct vanuit het paneel Signal Overview (Signaaloverzicht) worden 

toegevoegd. Om een voorvalperiode toe te voegen, verplaatst u de cursor naar het paneel Periods 

(Perioden) en klikt u met de muis. Het menu Event period (voorvalperiode) zal verschijnen zoals 

hieronder weergegeven.  

 



Handleiding Noxturnal 

   

~ 50 ~ 

Uitsluiting van ongeldige gegevens kan worden uitgevoerd in het paneel Signal Overview 

(signaaloverzicht). Om ongeldige gegevens uit te sluiten van de registratie, verplaatst u de cursor naar 

één van de signalen, klikt u op de linkermuisknop en selecteert u een gebied door naar links/rechts te 

slepen. Laat de muisknop los. Vervolgens wordt het onderstaande menu weergegeven. De voorvallen 

die als 'Invalid Data' (Ongeldige gegevens) zijn gemarkeerd, worden van de rapportberekeningen 

uitgesloten. 

 

 

Eenheden instellen 

Om het gebruikte eenhedenstelsel voor bijvoorbeeld lengte en gewicht te wijzigen, navigeert u naar 
Tools > Settings…  (Tools > Instellingen...) in de Noxturnal-taakbalk. Op de pagina General (Algemeen) 
zoekt u de vervolgkeuzelijst System Units (Systeemeenheden) en selecteert u het betreffende te 
bewerken veld. 
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Signalen bekijken 

Menuknop Werkruimte 

Met de Workspace Menu Button  (menuknop Werkruimte) kunt u verschillende 

werkruimtelayouts en signaalbladen toepassen om de manier waarop u uw registraties wilt zien te 

beheren. De werkruimtelayouts bevatten een selectie van signaalbladen en 

signaalbladeigenschappen. Noxturnal voorziet in een reeks standaard werkruimtelayouts 

(ademhalings- en PSG-layouts) en signaalbladen. U kunt ook aangepaste werkruimtelayouts en 

signaalbladen instellen. U kunt alle wijzigingen in uw werkruimtelayout opslaan voor toekomstig 

gebruik. Dit betekent dat u instellingen kunt wijzigen en uw werkomgeving kunt inrichten zoals u dat 

wilt. 

 

U kunt de menuknop Workspace (Werkruimte) gebruiken voor de bewerking Add Sheet (Blad 

toevoegen), voor het aanmaken van een New Workspace Layout (Nieuwe werkruimtelayout), waarbij 

u een standaard layout als basis gebruikt of zelfs voor Revert Layout (Layout terugzetten) na het 

maken van wijzigingen. 

 

Om een aangepast signaalblad op te slaan, klikt u met de rechtermuisknop op de signaalbladtab en 

selecteert u Save Sheet Layout As... (bladlayout opslaan als...). Als u het aangepaste signaalblad hebt 

opgeslagen, kunt u altijd kiezen voor Update Saved Layout (Opgeslagen layout updaten) als 

aanvullende wijzigingen worden doorgevoerd. Zie voor meer informatie over signaalbladen de 

paragraaf Signaalbladen. 
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Signaalbladen 

Een signaalblad toont een of meer signalen in een tabvenster in de werkruimte. Noxturnal wordt 

geleverd met voorgedefinieerde signaalbladen, zoals de bladen Respiratory (ademhaling), PSG en 

Pulse Oximeter (pulsoximeter). 

Om signalen aan een signaalblad toe te voegen of eruit te verwijderen, navigeert u de muis naar het 

taakvenster Signals and Data (Signalen en gegevens) rechts van de werkruimte. Als de cursor boven 

deze tab staat, verschijnt het taakvenster Signals and Data (signalen en gegevens). Een lijst van alle 

beschikbare signalen wordt in dit taakvenster weergegeven. Een selectievakje naast het signaal 

bepaalt of het signaal al dan niet in het blad wordt weergegeven. Vink het vakje aan of haal het vinkje 

weg om het signaal aan het blad toe te voegen of eruit te verwijderen. Zie hieronder het tabblad 

Signals and Data (signalen en gegevens). 
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Werken met signalen 

 

De navigatiebalk maakt snelle navigatie mogelijk naar elk moment in de registratie. De blauwe 

lijn geeft aan waar in de registratie de gebruiker zich bevindt. Klik op een plaats in de balk om 

naar dat moment te gaan. 

De tijd-as geeft de registratietijd en de tijdperiode in het venster weer. Klik met de 

rechtermuisknop op de tijd-as om het interval in het venster te wijzigen. Rek de tijd-as uit of 

maak deze smaller met de muis om het tijdinterval in het venster te wijzigen. 

De synchronisatiemarker op de tijd-as wordt gebruikt voor het synchroniseren met andere 

signaalbladen en weergaven. De klok aan de rechterzijde van de navigatiebalk toont de tijd van 

de markerpositie. De synchronisatiemarker kan in de tijd worden gesleept en verplaatst. 

De signaalwaarde-as toont de naam van het bijbehorende geplotte signaal en de schaal van de 

waarde-as. De as kan met de muis worden uitgerekt/smaller worden gemaakt. Om de 

eigenschappen van de waarde-as te wijzigen, dubbelklikt u op de as. Er wordt dan een dialoog 

weergegeven waarmee de eigenschappen kunnen worden gewijzigd. 

Signaalplot in een deelvenster. Signalen kunnen op vele manieren worden bijgesteld. Verander 

de grootte van het signaaldeelvenster of verplaats het signaaldeelvenster door de muis te 

gebruiken. Om de eigenschappen van het signaal te wijzigen, dubbelklikt u op het signaal. Er 

wordt dan een dialoogvenster weergegeven waarin de signaaleigenschappen kunnen worden 

gewijzigd. Voor toegang tot alle acties voor een individueel signaalspoor klikt u met de 

rechtermuisknop op het signaalspoor, waarna het volgende menu verschijnt. 
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Toetsenbordnavigatie 

Navigeer en manipuleer het signaalblad door de volgende shortcuttoetsen in te drukken: 
 
Navigatie: 

• Pijl-rechts = standaard - halve pagina vooruitspringen, configureerbaar door de gebruiker 

• Pijl-links = standaard - halve pagina terugspringen, configureerbaar door de gebruiker 

• Ctrl + pijl-rechts= standaard - hele pagina vooruitspringen, configureerbaar door de gebruiker 

• Ctrl + pijl-links= standaard - hele pagina terugspringen, configureerbaar door de gebruiker 

• PageDown-toets = pagina vooruitspringen 

• PageUp-toets = pagina terugspringen 

• Home-toets = Start van de registratie 

• End-toets = Einde van de registratie 

• Shift + pijl-rechts = Vergroot de aangegeven tijd in het venster 

• Shift + linkertoets = Verlaagt de aangegeven tijd in het venster 

• Shift + Ctrl + linkertoets = Spring naar de vorige datasessie 

• Shift + Ctrl + rechtertoets = Spring naar de volgende datasessie 

• - toets = Uitzoomen uit de selectie 

• + toets = Inzoomen in de selectie 

• Muiswieltje = Vooruit-/achteruitbladeren 

• Muiswieltje + Ctrl-toets = Omhoog- en omlaagbladeren 

Actief signaal: 

• Shift + Up = Signaalschaling verhogen 

• Shift + Down = Signaalschaling verlagen 

• Ctrl + Up = Signaal omhoogschuiven 

• Ctrl + Down = Signaal omlaagschuiven 

• Shift + Enter = Toon actief signaal in nieuw blad 
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• Shift + Delete = Verwijder actief signaal uit blad 

• Up-toets = Selecteer bovenstaand signaal 

• Down-toets = Selecteer onderstaand signaal 

• Ctrl + F = Voorvallen zoeken 

• F9 = Signaal automatisch schalen 

Signaalblad: 

• Spatie = Afspelen/Pauzeren registratie terugspelen 

• Ctrl + W = Signalen automatisch schalen 

• Ctrl + A = Signalen schikken 

Voorvallen: 

• Tab = Volgende voorval, indien u naar het volgende zoekresultaat zoekt 

• Shift + Tab = Vorige voorval, indien u naar het vorige zoekresultaat zoekt 

• Delete = Geselecteerde voorvallen verwijderen of voorvallen verwijderen die de selectie 

overlappen 

• Return = Deselecteren van alle voorvallen 

• Esc = Verwijderen van alle selecties 

Werken met voorvallen 

Voorvallen worden gebruikt voor het identificeren van interessegebieden in een signaal. Een voorval 

heeft een start- en een stoptijd en een type dat wordt gebruikt om het te classificeren. Voorvallen 

kunnen handmatig worden toegevoegd aan een signaal of door de automatische analyse van een 

score worden voorzien om interessegebieden te markeren. Voorvallen kunnen worden veranderd of 

verwijderd. 

Scoretoekenning van een voorval 

Om een voorval te scoren, gaat u naar een blad dat signalen bevat; lokaliseer een gebied op een 

signaal van interesse. 

 Markeer met de linkermuisknop een gebied om het voorval van een score te voorzien. 

 Druk op de sneltoets voor dat voorval. Sneltoetsen kunnen worden toegewezen aan een 

voorvaltype vanuit Setting -> Event Types & Groups -> Edit -> Behavior (Instellingen -> Voorvaltypen 

&groepen -> Bewerken -> Gedrag). 
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Een andere methode voor het toekennen van een score aan een voorval is het markeren van een 

gebied met de linkermuisknop, zoals eerder, maar dan door met de rechtermuisknop op het gebied te 

klikken en een voorval in de lijst te selecteren. 

Scoretoekenning met een enkele klik 

Noxturnal biedt de optie om een score toe te kennen met één klik: Single Click Scoring. Om scoren 

met één enkele klik te activeren, klikt u op het pictogram in de Noxturnal taakbalk.  

 

Binnen het betreffende signaalblad kent u handmatig een score toe aan een voorval op het 

desbetreffende signaalspoor. Zie voor instructies over het handmatig toekennen van een score aan 

een voorval de bovenstaande paragraaf Scoretoekenning van een voorval. Als u aan het eerste voorval 

een score hebt toegekend, kunt u met de functie scoren met één klik doorgaan met het toekennen 

van een score aan hetzelfde voorvaltype met slechts één muisklik terwijl u door de registratie bladert. 

Een voorval verwijderen 

Er zijn verscheidene manieren om bestaande voorvallen te verwijderen: 

• Selecteer een voorval door er met de linkermuisknop op te klikken en vervolgens op de toets 

Delete (Verwijderen) te drukken. 

• Klik met de rechtermuisknop op een voorval en selecteer Remove Event (Voorval 

verwijderen). 

• Selecteer met de muis een gebied dat kruist met de voorvallen om dit te verwijderen en druk 

op de toets Delete (Verwijderen). 
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Een voorval verplaatsen 

Om een voorval te verplaatsen, selecteert u het voorval door de linkermuisknop ingedrukt te houden 

en het voorval dan naar de gewenste plaats te slepen. Voorvallen kunnen tussen signalen worden 

gesleept en naar een andere tijdsperiode. 

De grootte van een voorval wijzigen 

Om de grootte van een voorval te veranderen, verplaatst u de muiscursor over de linker- of 

rechterbegrenzing van een voorval. De cursor moet veranderen in een pictogram van een pijl die naar 

rechts en links wijst. Zodra het pictogram in een pijl is veranderd, klikt u met de linkermuisknop en 

sleept u het voorval naar de gewenste duur. 

Door voorvallen navigeren 

Er zijn verscheidene manieren om door gescoorde voorvallen te navigeren in de registratie: 

• Spring tussen de voorvallen waaraan een score is toegekend op een signaal door op het 

signaal te klikken en de Tab-toets in te drukken waardoor u naar het volgende voorval in de 

tijd springt. Om naar het vorige voorval in de tijd te springen drukt u op de Shift- + Tab-toets. 

• In de rechterbovenhoek van de werkruimte ziet u een zoektekstvak dat u kunt gebruiken om 

te zoeken naar voorvallen waaraan een score is toegekend. Door op het tekstvak te klikken 

verschijnt een vervolgkeuzelijst van alle voorvaltypen waaraan scores zijn toegekend. Om te 

zoeken naar voorvallen van een bepaald type klikt u op het voorvaltype in de lijst. Dit toont 

het volgende voorval in de tijd met dat type. Klik op de navigatieknoppen in de 

vervolgkeuzelijst om door de voorvallen te navigeren. 

• Selecteer View > Event Overview (Bekijken > Voorvaloverzicht) in de Noxturnal-taakbalk om 

een overzichtsvenster weer te geven dat alle voorvallen waaraan in de registratie een score 

is toegekend in een plot weergeeft. Om naar een specifiek voorval te navigeren, klikt u erop 

in het overzichtsplot. 

Voorvallen die artefacten overlappen  

Voorvallen die overlappen met artefacten worden geteld. Voorvallen die ongeldige gegevens 

overlappen, worden echter niet meegeteld en worden vervaagd getekend. Zie onderstaande 

afbeelding:  
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Twee Desats (desaturaties) waarvan één met overlappend artefact, beide op dezelfde manier 

getekend 

 

Twee Desats (desaturaties), één wordt vervaagd getekend omdat deze niet wordt geteld 

  



Handleiding Noxturnal 

   

~ 59 ~ 

Analyseprotocollen 

Een Analyseprotocol is een groep detectors die op de registratie kunnen worden uitgevoerd om 
verscheidene voorvallen te detecteren en te markeren binnen de geregistreerde signalen. De 
beschikbare analyseprotocollen, inclusief de standaardprotocollen, worden genoemd onder het menu 
Analysis (Analyse). Om een analyseprotocol uit te voeren op de registratie selecteert u de betreffende 
analyse uit het menu Analysis (Analyse) en klikt u erop. 

Noxturnal biedt een reeks standaard analyseprotocollen en u kunt ook een nieuw analyseprotocol 

aanmaken dat gebruikt maakt van aangepaste instellingen en/of -detectors. Om een aangepast 

analyseprotocol in te stellen, gaat u naar Analysis > Manage Protocols (Analyse > Protocollen 

beheren) in de Noxturnal-taakbalk. U kunt een bestaand protocol bewerken en hernoemen of een 

nieuwe op basis van een bestaand protocol aanmaken.  

 

In dit voorbeeld zullen we een nieuw analyseprotocol aanmaken. Selecteer New (Nieuw) in het 

dialoogvenster Manage Analysis (Analyse beheren). Een nieuw analyseprotocol-blad wordt geopend, 

waarin het nieuwe protocol kan worden gedefinieerd. Een protocol is een verzameling detectoren en 

de functie van een detector is het lokaliseren van interessegebieden binnen een signaal en het 

toekennen van scores aan de gebieden met voorvallen.   
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Om een detector aan het protocol toe te voegen, kiest u een detector uit de lijst met detectoren en 

selecteert u Add Detector >> General Properties (Detector toevoegen >> Algemene eigenschappen); 

vervolgens kan het invoersignaal worden bewerkt.   

Als u uw analyseprotocol instelt, klikt u op Save and Close (Opslaan en afsluiten). Het protocol wordt 

aan de lijst van beschikbare analyses toegevoegd.  

Werken met scoretoekenningen 

Een scoretoekenning is een verzameling voorvallen waaraan scores worden toegekend op basis van 

signalen in de registratie. De acties voor het werken met scoretoekenningen vindt u in de Scoring 

Button (Scoretoekenningsknop) in de Noxturnal-taakbalk. De acties voor het werken met 

scoretoekenningen worden in de onderstaande paragrafen vermeld.  

  

Als u een Analysis protocol (Analyseprotocol) hebt opgenomen in het registratietype dat voor de 

registratie is geconfigureerd, dan gebruikt Noxturnal bij het downloaden vanuit een Nox-

registratieapparaat automatisch het standaardanalyseprotocol voor het analyseren van de registratie. 

Voor onlineonderzoeken moet u de registratie afsluiten als deze is voltooid en indien geopend vanuit 

de registratiebibliotheek analyseert de gedefinieerde standaardanalyse de gegevens. Het automatisch 

analyseren van de gegevens genereert een nieuwe scoretoekenning met de naam Untitled Scoring 

(Titelloze scoretoekenning), zie bovenstaande schermafbeelding. In de Scoring Button 

(Scoretoekenningsknop) ziet u altijd de geselecteerde scoretoekenning die voor het rapporteren en 

registreren van overzichtsfuncties wordt gebruikt. U kunt gemakkelijk nieuwe scores toekennen door 
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gebruik te maken van de functies van de Scoring Button (Scoretoekenningsknop), bijvoorbeeld als u 

wijzigingen doorvoert in de automatische scoretoekenning kunt u ze gemakkelijk opslaan als nieuwe 

scoretoekenning, met de van toepassing zijnde naam. 

 

Vanuit de Scoring Button (Scoretoekenningsknop) kunt u ook met Add Event Period (Voorvalperiode 

toevoegen) of Add Tech Note (Technische notitie toevoegen) een voorvalperiode of technische 

notitie aan de registratie toevoegen. 

Nieuwe scoretoekenning 

Bij gebruik van apparaten die een EEG registreren, kunt u gebruikmaken van de 
slaapstadiëringsfuncties van Noxturnal. Noxturnal biedt een automatische slaapstadiëring bij het 
systeem die helpt bij het handmatig toekennen van scores.  Het is ook mogelijk handmatig 
slaapstadiëring uit te voeren zonder eerst gebruik te maken van de automatische slaapstadiëring. 
Voor het uitvoeren van een handmatige slaapstadiëring klikt u op de Scoring button 
(Scoretoekenningsknop) en selecteert u New Scoring (Nieuwe scoretoekenning).  
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Daarna kunt u, om de slaapstadiëring te starten, de actie Start Sleep Staging (Slaapstadiëring starten) 

kiezen in het menu in de Scoring Button (Scoretoekenningsknop). De nummertoetsen op uw 

toetsenbord worden gebruikt voor de standaard slaapstadiëringhotkeys. U kunt de 

scoretoekenningshotkeys veranderen zoals hieronder wordt uitgelegd. 

De Scoring Button (Scoretoekenningsknop) is ook de knop waarmee u uw biokalibratie kunt starten. 

Een scoretoekenning selecteren 

Meerdere scoretoekenningen kunnen in verband worden gebracht met één enkele registratie. Alle 

beschikbare scoretoekenningen worden in het scoretoekenningspaneel vermeld. Selecteer de actieve 

scoretoekenning door erop te klikken. 

Scoretoekenning opslaan 

Sla de actieve scoretoekenning op door te klikken op de optie Save Scoring (Scoretoekenning 

opslaan). De gebruiker wordt gevraagd om een naam voor de opgeslagen scoretoekenning. De 

opgeslagen scoretoekenning wordt toegevoegd aan de lijst met scoretoekenningen. 

Scoretoekenning wissen 

Als een scoretoekenning actief is, zal deze actie haar wissen. Als de actieve scoretoekenning lokale 

wijzigingen heeft, wordt de gebruiker gevraagd of hij zijn lokale wijzigingen wil opslaan. 

Geselecteerde scoretoekenning verwijderen 

Een opgeslagen scoretoekenning kan worden verwijderd door haar te selecteren in de 

scoretoekenning en te klikken op de optie Delete Selected Scoring (Geselecteerde scoretoekenning 
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verwijderen). Er wordt een prompt weergegeven die vraagt of het OK is om de scoretoekenning te 

verwijderen. 

Scoretoekenning toetsenbordsneltoetsen 

Een sneltoets wordt gebruikt om voorvallen snel te scoren. Sneltoetsen kunnen worden toegewezen 

aan een voorvaltype vanuit Setting -> Event Types & Groups -> Edit -> Behavior (Instellingen -> 

Voorvaltypen & groepen -> Bewerken -> Gedrag). 

De algemene regel is dat voorvallen eigenlijk slechts één toetsenbordteken als sneltoets mogen 

hebben, maar een combinatie van Ctrl, Shift en Alt plus een toetsenbordteken wordt wel 

ondersteund. 

Noxturnal-rapporten 

 

 NB: De rapportresultaten staan vast en worden niet geüpdate als de analyse van 

de registratie verandert. 

 NB: Als wijzigingen worden doorgevoerd in de analyse, kan een ander rapport 

worden gegenereerd of kan het bestaande rapport worden ververst. 

Noxturnal voorziet in een reeks standaardrapporten die toegankelijk zijn door te klikken op het menu 

Reports (Rapporten) vanuit de Noxturnal-taakbalk.  

Rapporten genereren 

Een rapport kan worden gegenereerd door op de knop View Report (Rapport bekijken) te klikken op 

de registratieresultatenpagina of door een rapport te kiezen in het menu Reports (Rapporten) in de 

Noxturnal-taakbalk. 

Als u een rapport in het rapportsysteem hebt gegenereerd, kunt u het rapport gemakkelijk wijzigen 

door gebruik te maken van de knop Edit (Bewerken) die zichtbaar is in de taakbalk bij het bekijken van 

rapporten. 

 

De knop Edit (Bewerken) activeert de bewerkingsmodus waarmee u het rapport kunt bewerken op 

dezelfde manier als wanneer u gebruik zou maken van Microsoft Word®. Alle wijzigingen die u 

doorvoert, zijn onmiddellijk voor u zichtbaar. U kunt ook nieuwe indices toevoegen en zelfs 

voorgedefinieerde rapportonderdelen als u een onderzoek interpreteert. Om de bewerkingsmodus te 

stoppen drukt u opnieuw op de knop Edit (Bewerken). Wijzigingen die worden doorgevoerd in de 

bewerkingsmodus worden niet als onderdeel van de rapporttemplate opgeslagen. 

Rapporten aanpassen 

Noxturnal voorziet in een krachtig rapport-op-maatsysteem dat op Microsoft Word® lijkende 

mogelijkheden bevat. Rapporten in Noxturnal kunnen gemakkelijk aan uw wensen worden aangepast. 

Voor het aanmaken van een rapport-op-maattemplate volgt u de onderstaande stappen. 
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1. Selecteer vanuit de Noxturnal-taakbalk Reports > Manage Rapporten… (Rapporten > 

Rapporten beheren…). 

2. In het dialoogvenster Manage Reports (Rapporten beheren) selecteert u één van de opties 

Edit (Bewerken), New (Nieuw) of New Based On (Nieuw op basis van), afhankelijk van uw 

voorkeuren. 

3. 

In dit voorbeeld maken we een nieuw aangepast rapport aan op basis van het standaard 

PSG-rapport. Selecteer het PSG-rapport in de lijst van beschikbare rapporten en klik op New 

Based On (Nieuw op basis van). 

4. U ziet het volgende dialoogvenster waarin u het nieuwe rapporttemplate een naam kunt 

geven. Vervolgens selecteert u Create (Aanmaken).  

Er wordt een nieuw blad geopend met het standaard gekozen rapport. In dit venster kunt u 

het bewerken. Aan de rechterkant van het scherm ziet u een verzameling Fields (Velden) en 

Report Parts (Rapportonderdelen) die u voor uw rapport kunt gebruiken. Zie voor meer 
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informatie over rapportonderdelen en velden de onderstaande paragraaf Rapportonderdelen 

en rapportvelden. 

 

NB: In het rapporttemplate kunt u over de velden (-) bewegen met de muis om de details van de 

parameters te zien. Zie onderstaande afbeelding. 

 

RAPPORTONDERDELEN EN RAPPORTVELDEN 

Elk rapportonderdeel vertegenwoordigt een paragraaf van uw rapport, zoals Oximetriesaturatie, PLM-

details, etc. Rapportonderdelen en -velden kunnen worden aangemaakt in Noxturnal en u kunt 

rapportonderdelen opslaan uit standaardrapporten om beschikbaar te hebben bij het vanaf het begin 

aanmaken van rapporten. 

EEN NIEUW RAPPORTONDERDEEL AANMAKEN 

U kunt nieuwe rapportonderdelen aanmaken en opslaan voor later gebruik. Om dat te doen, 

selecteert u het desbetreffende rapportonderdeel in de rapporttemplate (of een aangepaste 

tekst/tabel) die u naar de lijst van Report Parts (Rapportonderdelen) sleept en verplaatst. Geef het 
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rapportonderdeel een naam en selecteer de categorie. Het nieuwe rapportonderdeel dat u hebt 

aangemaakt, zal aan de lijst van rapportonderdelen worden toegevoegd. 

 

EEN NIEUW RAPPORTVELD AANMAKEN 

U kunt nieuwe rapportvelden aanmaken en opslaan voor later gebruik. Om dat te doen, volgt u de 

onderstaande stappen. 

1. In dit voorbeeld zullen we het standaardveld Desat Drop ≥ 4% Count (Desatuaratiedaling ≥ 

4% telling) dat beschikbaar is in Noxturnal als basis selecteren voor ons aangepaste veld. 

Selecteer Desat Drop ≥ 4% Count (Desaturatiedaling ≥ 4% telling) en klik op New Based On 

(Nieuw op basis van). 
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2.  In de dialoog Edit Report Field (Rapportveld bewerken) geeft u het nieuwe veld een naam en 

bewerkt u de eigenschappen van het nieuwe veld zoals vereist. 

  

In dit voorbeeld zullen we de desaturatiedaling veranderen in ≥ 3 en het nieuwe veld een 

beschrijvende naam geven, Desat Drop ≥ 3% Count (Desaturatiedaling ≥ 3% telling). Als de condities 

moeten worden gewijzigd, klikt u op Conditions (Condities) om alle beschikbare condities te zien. 

RAPPORTONDERDELEN EN -VELDEN AAN RAPPORTEN TOEVOEGEN 

Om rapportonderdelen en -velden aan uw rapport toe te voegen, verplaatst u de cursor naar de 

voorkeurslocatie in het rapport en dubbelklikt u op het gewenste rapportonderdeel in de lijst aan de 

rechterkant. Een andere manier om een rapportonderdeel en -veld aan een rapport toe te voegen, is 

om het gewenste rapportonderdeel/-veld in uw rapport te slepen en in uw rapport te plaatsen. 

KOPTEKST EN VOETTEKST VAN EEN RAPPORT 

Om de koptekst en voettekst van het rapport aan te passen, volgt u de onderstaande stappen. 

1. Vanuit de Noxturnal-taakbalk selecteert u Tools > Settings > User & Company (Tools > 

Instellingen > Gebruiker en Bedrijf). U ziet dan de volgende wizard waar u gebruikers- en 

bedrijfsinformatie kunt invullen.  
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Vul de bovenstaande velden in met alle van toepassing zijnde informatie. U kunt de 

informatie ingevoerd in uw rapport invoegen met gebruikmaking van de 

overeenkomstige rapportvelden.  

 

2. Om de informatie in te voegen in de koptekst/voettekst van uw rapport plaatst u de 

cursor binnen het bovenste gedeelte van het rapport, klikt u met de rechtermuisknop en 

selecteert u de optie Edit Header/Footer (Koptekst/voettekst bewerken). 

 

 

3. Voeg de van toepassing zijnde velden uit de lijst met beschikbare velden toe aan het 

koptekstgedeelte. 

4. Om een logo toe te voegen aan uw koptekst klikt u op Format -> Insert Image...  

(Indeling -> Afbeelding invoegen...) zoals hieronder weergegeven. 
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5. Om paginanummering toe te voegen aan uw rapport, gaat u naar het einde van de 

rapportpagina, klikt u met de rechtermuisknop en selecteert u Edit Footer (Voettekst 

bewerken). Klik met de rechtermuisknop binnen het voettekstgebied en selecteer 

Insert > Page Number (Invoegen > Paginanummer). 

Als u klaar bent met het instellen van uw rapporttemplate selecteert u Save (Opslaan). Uw rapport 

wordt toegevoegd aan de lijst met rapporten die beschikbaar is vanuit de Noxturnal-taakbalk. 

Rapporten exporteren 

Om een rapport te exporteren, klikt u op Export (Exporteren) vanuit de rapporttaakbalk. 

 

Dit opent een nieuwe dialoog voor het specificeren van het bestandsformaat en de bestandsnaam. 

Klik op de knop Save (Opslaan) als u klaar bent. Het rapport wordt op de schijf in het gespecificeerde 

bestandsformaat opgeslagen. 

Rapporten afdrukken 

Nadat een rapport is gegenereerd, kan de gebruiker het rapport afdrukken. Om een rapport af te 

drukken, selecteert u de optie Print (Afdrukken) in de rapporttaakbalk. 

 

Een dialoog wordt geopend waarin de afdrukmogelijkheden kunnen worden gewijzigd. Klik op de 

knop Print (Afdrukken) om af te drukken. 

De registratiebibliotheek 

De registratiebibliotheek toont en beheert alle registraties die zijn gedownload van de Nox-

registratieapparaten en de onlineonderzoeken. Als registraties worden geopend of gedownload in 
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Noxturnal worden ze automatisch toegevoegd aan de registratiebibliotheek. Het is ook mogelijk om 

licenties te verkrijgen waarmee u EDF-bestanden, EDF+-bestanden, Embla-bestanden en Somnostar-

bestanden in Noxturnal  kunt openen. De overeenkomende registraties worden automatisch aan de 

registratiebibliotheek toegevoegd.  

Om een registratie te openen, moet u de registratie in de registratiebibliotheeklijst selecteren en erop 

dubbelklikken. 

Registraties archiveren 

Registraties in de registratiebibliotheek kunnen worden gearchiveerd naar een andere locatie of naar 
een permanente opslag. Om een registratie te archiveren selecteert u één of meer registraties in de 
bibliotheek en klikt u op de knop Archive Recording...  (Registratie archiveren) in het registratie-
informatiepaneel. Er verschijnt een dialoog die de gebruiker door het archveringsproces leidt.  
 

Single Body Source (enkele lichaamsbron) 

Het algoritme Single Body Source (enkele lichaamsbron) is een algoritme in Noxturnal waarvoor een 

octrooi is aangevraagd. Het algoritme stelt vast of het registratieapparaat en de bijbehorende 

sensoren tijdens de registratieperiode  door dezelfde persoon zijn gedragen. 

Het algoritme leidt tot één van drie resultaten. De resultaten en hun betekenissen worden hieronder 

beschreven. 

• Not analyzed (Niet geanalyseerd): Het algoritme is niet op de registratie uitgevoerd. 

• Approved (Goedgekeurd): Eén lichaamsbron kan voor de registratie worden geverifieerd. 

• Inconclusive (Onzeker): Eén lichaamsbron kan niet voor de registratie worden geverifieerd. 

Verschillende factoren kunnen leiden tot een onzeker resultaat, waaronder de volgende: 

• De registratie bevat niet de benodigde signalen (een puls-golfvormsignaal van de oximeter 

en minimaal één RIP-signaal). 

• De benodigde signalen hebben ruis of bevatten prominente artefacten. 

• De sensoren waren niet op de persoon aangebracht. 

• De sensoren waren onjuist op de patiënt aangebracht of zijn tijdens de slaap verplaatst. 

• De oximeter en de RIP-banden werden door verschillende personen gedragen. 

• De registratie is te kort (ten minste 15 minuten van gelijktijdig geregistreerde puls-

golfvormsignalen en RIP-signalen zijn nodig) 

• Het cardiale artefact in de RIP-signalen (veroorzaakt door de emissie van bloed van het hart 

naar de bloedvaten en de daaruit volgende torsobeweging) is te klein. 

Het Single Body Source-algoritme (Enkele lichaamsbron-algoritme) kan ofwel als tool draaien (door te 

klikken op Tools -> Single Body Source (Tools -> Enkele lichaamsbron)) ofwel als analysedetector 

opgenomen in een aangepast analyseprotocol. De tool draait automatisch nadat registraties van een 

registratieapparaat zijn gedownload. 

Het resultaat van het algoritme wordt voor elke nacht weergegeven op de pagina Recording Results 

(Registratieresultaten) onder de paragraaf Signal Overview (Signaaloverzicht) en is ook beschikbaar 
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als rapportveld dat opgenomen kan worden in een aangepast rapport. Het resultaat wordt door 

middel van één van onderstaande symbolen weergegeven: 

 

Niet geanalyseerd 

  

Een grijze cirkel 

                                                           

Goedgekeurd  

 

Een wit vinkje in een groene 

cirkel  

                

Onzeker      

 

Een wit vraagteken in een 

gele cirkel  

 

De automatische berekening van het Single Body Source-algoritme (Enkele lichaamsbron-algoritme) 

voor gedownloade registraties en de weergave van het resultaat kunnen worden in- en uitgeschakeld 

onder Tools -> Settings... -> Advanced -> Single Body Source (Tools -> Instellingen... -> Geavanceerd -

> Enkele lichaamsbron).  
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Compatibele apparaten 

In de volgende tabel worden de door ethernet ondersteunde apparaten en schakelaars vermeld die 

goedgekeurd zijn voor gebruik met de Nox-slaapbeoordelingssystemen. Noxturnal kan signalen van 

door ethernet ondersteunde apparaten ontvangen, synchroniseren, weergeven en opslaan, als ze met 

hetzelfde netwerk zijn verbonden.  

SCHAKELAARS, IP-CAMERA'S EN MICROFOONS 

Type Catalogusnummer 

Trendnet PoE schakelaar NVT 

Axis T8351, microfoon 3,5 mm NVT 

Axis P3374, internetprotocol-camera NVT 

ONDERSTEUNDE HULPAPPARATEN 

Type Catalogusnummer 

SenTec SDM NVT 

Resmed TxLink NVT 

Resmed AirsenseTM10 NVT 

Resmed S9TM NVT 

Resmed Aircurve NVT 
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Regelgevingsinformatie 

Prestatietests en validatieoverzicht 

Het Nox-slaapbeoordelingssysteem is getest en geverifieerd in verschillende fasen. Dit oimvat interne 

tests, verificatie en validatie alsmede externe tests ter waarborging van de productveiligheid, 

effectiviteit en betrouwbaarheid. Het ontwerp is geverifieerd en gevalideerd, inclusief klinische 

evaluatie, gedurende het gehele ontwerpproces, in overeenstemming met de specificaties van de 

vereisten en het beoogde gebruik.  

Nox Medical is houder van een ISO 13485:2016 (MDSAP) gecertificeerd kwaliteitsbewakingssysteem 

dat in overeenstemming is met de eisen van de Richtlijn inzake medische hulpmiddelen (MDD) - 

Richtlijn 93/42/EEC zoals gewijzigd door Richtlijn 2007/47/EC); Canada -Medical Devices Regulations - 

deel 1 - SOR 98/282; Australië - Therapeutic Goods (Medical Devices) Regulations, 2002, bijlage 3 deel 

1 (exclusief Part 1.6) – Full Quality Assurance Procedure; Japan – MHLW Ministerial Ordinance 169, 

artikel 4 - artikel 68; PMD Act en USA – 21 CFR 820, 21 CFR 803, 21 CFR 806, 21 CFR 807 – subdelen A 

tot D. 

Beschrijving van symbolen en afkortingen 

PG  Polygrafie 

PSG  Polysomnografie 

 
 CE-markering die conformiteit aangeeft met de 

betreffende Europese richtlijnen. 

(01)15694311110255(8012)VVvvr

r(11)JJMMDD(10)JJMMDD 

 Unique Device Identifier (unieke 
apparaatidentificatiecode, UDI); de applicatie-
identificatiecode (01) geeft de 
apparaatidentificatiecode (device identifier (DI)) weer 
("15694311110255"), de applicatie-identificatiecode 
(8012) geeft de softwareversie weer (VVvvrr), de 
applicatie-identificatiecode (11) vertegenwoordigt de 
productiedatum/fabricagedatum ("JJMMDD", waarbij 
"JJ" de laatste twee cijfers van het productiejaar zijn, 
"MM" de productiemaand en "DD" de productiedag), 
en de applicatie-identificatiecode (10) het lot-nummer 
vertegenwoordigt ("ZZZZZZ") 

 

 Unique Device Identifier (unieke apparaatidentificatie 
(UDI)) weergegeven in data-matrixformaat op de 
Noxturnal-CD 

 
 Fabrikantinformatie 

 
 Productiedatum 
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 Batchcode/Partijnummer 

  Catalogusnummer/Referentienummer 
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Over 

Deze handleiding en de bijbehorende vertalingen worden in elektronisch formaat verstrekt in 

overeenstemming met Verordening (EU) nr. 207/2012 van 9 maart 2012 betreffende elektronische 

instructies voor gebruik van medische hulpmiddelen. Ze zijn ook beschikbaar in elektronisch formaat 

op de website van Nox Mecial: www.noxmedical.com. 

Elektronische versies worden verstrekt als PDF-documenten en voor het openen van deze 

documenten is een PDF-reader nodig. PDF-readers zijn meestal kosteloos beschikbaar voor 

gebruikers. Zie de betreffende systeem- en hardwarevereisten van de PDF-reader die wordt gebruikt. 

Een versie op papier kan zonder extra kosten worden aangevraagd door een e-mail te sturen naar 
support@noxmedical.com. De versie op papier wordt binnen 7 kalenderdagen toegestuurd. 
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Bijlage 

Standaard afgeleide signalen 

Noxturnal berekent de standaard afgeleide signalen uit de geregistreerde bronsignalen. Afgeleide 
signalen zijn statistische of directe transformaties van elk willekeurig signaal en worden in de 
onderstaande tabel beschreven. 

Afgeleid signaal Bronsignaal Beschrijving 

Activiteit Gravity X en 
Gravity Y 
(Zwaartekracht 
X en 
zwaartekracht 
Y) 

Indicatie van patiëntactiviteit/bewegingen. Het 
activiteitssignaal wordt berekend uit de ruwe 
zwaartekracht-signalen (X- en Y-as) gemeten door de 
3-dimensionale versnellingsmeter in de Nox-
recorders. Het gemeten zwaartekracht-signaal wordt 
gedifferentieerd naar tijd en wordt geschaald door 
de juiste schalingsfactor om het afgeleide 
activiteitssignaal te creëren. 

Audio Volume 
(audiovolume) [dB] 

Audio Volume 
(audiovolume) 

Een audiovolume-signaal in logaritmische schaal 

(met eenheden van decibellen) wordt automatisch 

berekend uit het ruwe audiovolume-signaal, die in 

lineaire schaal is. De transformatie waarmee het 

signaal wordt berekend is V_dB = 20 log(x/P_0), 

waar V_dB het volume in decibellen is, P is het ruwe 

audiovolume-signaal (dit is een druksignaal in 

eenheden van Pa) en P_0 is de 

referentiegeluidsdruk, deze heeft een waarde van 

P_0 = 20 uPa in de Noxturnal-software.  

Calibrated RIP Abdomen 
(gekalibreerde RIP-buik) 

RIP Abdomen 
(RIP-buik)  

Het gekalibreerde RIP-buiksignaal wordt berekend 
door het schalen van elke waarde van het RIP-
buiksignaal met het overeenstemmende RIP-K-
signaal (afgeleide signaal). Het stroomsignaal wordt 
automatisch aangemaakt als zowel het RIP-
buiksignaal als het RIP-K-signaal bestaat. 

Calibrated RIP Flow 
(gekalibreerde RIP-
stroom) 

RIP Thorax (RIP-
thorax) 

De gekalibreerde RIP-stroom wordt berekend uit een 
afleiding van de som van het RIP-thoraxsignaal en 
het gekalibreerde RIP-buiksignaal (afgeleid) en heeft 
de eenheid [V/s].  

Calibrated RIP Sum 
(gekalibreerde RIP-som) 

RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

Het gekalibreerde RIP-somsignaal wordt berekend 

door het RIP-thoraxsignaal op te tellen bij het RIP-

buiksignaal nadat de laatstgenoemde met het RIP-K-

signaal  is geschaald.  

Cannula Flow 
(canulestroom) 

Cannula 
Pressure 
(canuledruk) 

Het canulestroomsignaal is een kwalitatief signaal 

dat afgeleid wordt uit het ruwe 

neuscanuledruksignaal en heeft de eenheid 

[cmH2O]. Het neuscanuledruksignaal is gefilterd met 

een laagdoorlaatfilter op 3 Hz en vervolgens wordt 
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Afgeleid signaal Bronsignaal Beschrijving 

het canulestroomsignaal uit een non-lineaire 

transformatie afgeleid.  

Cannula Snore (canule 
snurken) 

Cannula 
Pressure 
(canuledruk) 

Het snurksignaal (Cannula Snore) wordt afgeleid 
door een ruw neuscanuledruksignaal of 
luchtstroomsignaal te filteren met een 
hoogdoorlaatfilter.  

EMG Frontalis  E1-E3 en E2-E4 Het EMG.Frontalis-Left-signaal komt overeen met 
het opnieuw verwezen signaal E1-E3 en de het 
EMG.Frontalis-Right-signaal komt overeen met het 
opnieuw verwezen signaal E2-E4 

Flow Limitation 
(stroombeperking) 

Cannula 
Pressure 
(canuledruk) 

Het stroombeperkingssignaal wordt afgeleid door 
middel van een rekenkundige formule voor het 
berekenen van de vlakheid van een inademing.  

Heart Rate (Hartslag) ECG Een algoritme voor de detectie van R-golven wordt 
uitgevoerd om elke hartslag in het ECG-signaal  te 
detecteren. De directe hartslag is de wederkerigheid 
van de intervallen tussen opeenvolgende hartslagen. 
Het hartslagssignaal heeft de eenheid [bpm] (beats 
per minute (slagen per minuut)). 

Mask Pressure 
(maskerdruk) 

Raw Pressure 
(Ruwe druk) 

Het maskerdruksignaal wordt berekend op T3- en 
A1-apparaten, maar in latere versies van de 
apparaten wordt het maskerdruksignaal berekend in 
Noxturnal met behulp van het Raw Pressure-signaal, 
als het maskerdrukkanaal is opgenomen in het 
apparaatprofiel voor de registratie. De maskerdruk 
moet identiek zijn aan het signaal voor ruwe druk, 
maar met een ander signaaltype 

Nasal Pressure (Nasale 
druk) 

Raw Pressure 
(Ruwe druk) 

Het neusdruksignaal wordt berekend op T3- en A1-
apparaten, maar in latere versies van de apparaten 
wordt het neusdruksignaal berekend in Noxturnal 
met behulp van het Raw Pressure-signaal, als het 
maskerdrukkanaal is opgenomen in het 
apparaatprofiel voor de registratie. Het ruwe 
druksignaal wordt gefilterd met een 
hoogdoorlaatfilter om het nasale druksignaal te 
creëren. 

Positie Gravity X en 
Gravity Y 
(Zwaartekracht 
X en 
zwaartekracht 
Y) 

Een indicatie van de houding van de patiënt om 
onderscheid te maken tussen rechtop, rugligging, 
buikligging, links of rechts. Het Position-signaal 
wordt gemaakt uit Gravity X en Gravity Y en is de 
hoek van de rotatie van het lichaam. Het varieert van 
-180° tot 180° en is 0° als de patiënt recht omhoog 
kijkt. 

PTT ECG en Pleth PTT, of pulsdoorgangstijd, wordt gedefinieerd als de 
tijd tussen een R-golf in het ECG en een 
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Afgeleid signaal Bronsignaal Beschrijving 

overeenkomstige stijging van 50% van het pleth-
signaal (fotoplethysmografiesignaal van de oximeter) 
vanaf het dieptepunt. 

Pulse Wave Amplitude 
(pulsgolfamplitude) 

Plethysmogram Pulse Waveform Amplitude (PWA) is een signaal die 
de piek-tot-piek-waarde van een pulsgolfvorm (het 
fotoplethysmografie-signaal van de oximeter) 
weergeeft door middel van de methode 
bemonsteren en vasthouden voor de duur van de 
golf. De eenheid is [k]. 

RIP Sum (RIP-som) RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

De RIP Sum [V] wordt berekend als de som van het 
RIP-buiksignaal en het RIP-thoraxsignaal. 

RIP Flow (RIP-stroom) RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

De bandstroom wordt berekent uit een afleiding van 
de som van het RIP-buiksignaal en het RIP-
thoraxsignaal en heeft de eenheid [V/s]. 

RIP K (RIP-K) RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

Voor een nauwkeuriger schatting van de werkelijke 
ademhalingsstroom uit het RIP Abdomen-signaal en 
het RIP Thorax-signaal, moet het RIP-buiksignaal met 
behulp van een kalibratiefactor worden geschaald. 
Deze kalibratiefactor wordt opgeslagen als het 
afgeleide signaal K. De K wordt gevonden door de 
optimale waarde te vinden waarmee de beste 
correlatie tussen de afgeleide RIP-stroom en een 
referentie-pneumostroom tot stand komt. 

RIP Phase (RIP-fase) RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

Het faseverschil tussen de Rip-buikbanden en de RIP-
thoraxbanden. Het fasesignaal varieert van 0° tot 
180°. De RIP-Phase wordt weergegeven als een 
signaal dat met de RIP-buikbanden en de RIP-
thoraxbanden is gesynchroniseerd. 

RIP Inductance en Fast 
RIP Inductance (RIP-
inductantie en snelle 
RIP-inductantie) 

Raw RIP 
counters (Ruwe 
RIP-tellers) 

De RIP-inductantiesignalen worden berekend op A1-
apparaten, maar in latere versies van de apparaten 
worden de RIP-inductantiesignalen berekend in 
Noxturnal met behulp van de Abdomen Raw- en 
Thorax Raw-signalen (ruwe buik- en thoraxsignalen). 
Er wordt een overdrachtsfunctie toegepast op de 
ruwe signalen, die de resonantiefrequentie van de 
RIP-banden meten, om de inductantie van de 
banden te schatten. Er zijn twee versies van elk RIP-
inductantiesignaal beschikbaar, een bemonsterd op 
25 Hz en de andere op 200 Hz. 

RIP en Fast RIP (Snelle 
RIP) 

Raw RIP 
counters (Ruwe 
RIP-tellers) 

De RIP-signalen worden berekend op A1- en T3-
apparaten, maar in latere versies van de apparaten 
worden de RIP-signalen berekend in Noxturnal met 
behulp van de Abdomen Raw- en Thorax Raw-
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signalen (ruwe buik- en thoraxsignalen). De ruwe 
RIP-signalen worden gefilterd met een 
hoogdoorlaatfilter om de RIP-signalen te creëren. Er 
zijn twee versies van elk RIP-signaal beschikbaar, één 
bemonsterd op 25 Hz en de andere op 200 Hz. 

Referentie-EEG EEG-signalen Het referentie-EEG-signaal is een gemiddelde van 
twee of meer EEG-inputsignalen.  

Respiratory Rate 
(ademhalingsfrequentie) 

RIP Abdomen 
(RIP-buik) en 
RIP Thorax (RIP-
thorax) 

Het ademhalingsfrequentiesignaal wordt afgeleid 
van het RIP Sum-signaal (afgeleid signaal). De 
ademhalingsfrequentie wordt weergegeven als 
ademhalingen per minuut [rpm]. 

Set Pressure (ingestelde 
druk) 

Mask Pressure 
(maskerdruk) 

Het Set Pressure-signaal wordt gemaakt van het 
Mask Pressure-signaal. Het toont de meest 
voorkomende maskerdruk over een 5-seconden-
interval. 

TcCO2 [Pa] TcCO2 Het signaal, dat wordt ontvangen van een 
transcutaan CO2-apparaat, heeft de eenheid [torr]. 
Het nieuwe TcCO2-signaal, met de eenheid [Pa], 
wordt berekend met behulp van de schalingsfactor 
133,3 Pa/torr. 

Automatisch analyseoverzicht 

Er zijn klinische prestatietesten uitgevoerd op de automatische analyse die in Noxturnal plaatsvindt 

om de veiligheid en effectiviteit aan te tonen. De klinische prestatietesten bestonden uit het achteraf 

analyseren van bestaande klinische gegevens uit slaaponderzoeken die al eerder waren verzameld en 

waaraan handmatig scores waren toegekend als onderdeel van normale klinische zorg. Alle 

scoretoekenners waren gekwalificeerde polysomnografie-technologen en hebben de 

scoretoekenningsrichtlijnen van de AASM (American Academy of Sleep Medicine) gevolgd. Het 

onderzoeksprotocol bestond uit het exporteren van de gerapporteerde indices/voorvallen uit de 

bestaande handmatige scoretoekenning en het vervolgens draaien van de automatische analyse in 

Noxturnal op dezelfde klinische gegevens. De resultaten van de automatische scoretoekenning 

werden geëxporteerd en vergeleken met de resultaten van de handmatig toegekende scores.  De 

algemene conclusie van de klinische prestatietesten is dat de automatische analysetools van 

Noxturnal acceptabel zijn als scoretoekenningshulpmiddel in de klinische routine voor het klinische 

doel zoals gespecificeerd voor elke analyse in de tabel hieronder.  

De tabel hieronder beschrijft de automatische analyse in Noxturnal, geeft een kort overzicht van hoe 

het algoritme werkt en welke signalen worden geanalyseerd, beschrijft de criteria die worden 

gebruikt voor de scoretoekenning en welke indices/voorvallen/parameters worden 

berekend/gescoord. 

 Verder bevat de tabel informatie over de klinische doelen en beperkingen, de klinische aandoeningen 

die worden geanalyseerd, de veiligheidseindpunten gespecificeerd voor elke analyse en het type 

klinische gegevenssets die voor validatie worden gebruikt.  
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Naam, doel, indices, 
voorvallen  

Klinische aandoening Overzicht 

Bruxisme-analyse  

Het klinische doel is het 

verbeteren van de 

effectiviteit van het 

toekennen van scores aan 

EMG-gegevens op een 

manier die overeenkomt 

met mogelijke bruxisme-

gerelateerde voorvallen 

door mandibulaire 

bewegingen die zijn 

gemeten door een EMG van 

de kauwspieren te labelen 

voor beoordeling en 

bevestiging door een 

opgeleide zorgverlener.  

Beperkingen: Het is bekend 

dat de analyse het aantal 

bruxisme-voorvallen 

overschat en gemiddeld 

moeten mogelijk 42% van 

de automatisch gescoorde 

voorvallen handmatig 

worden verwijderd. Voordat 

een diagnose wordt gesteld 

moeten de resultaten van 

de automatische analyse 

altijd door een 

gecertificeerde technicus of 

een arts worden 

beoordeeld. 

Gescoorde index: Bruxism 

Episode Index (BEI 

(Bruxisme-episodesindex)) - 

aantal bruxisme-episodes 

per slaapuur 

 

Kaaksamentrekkingen 

tijdens de slaap. 

Kaaksamentrekkingen 

(mogelijke bruxisme-

gerelateerde voorvallen) 

worden geclassificeerd als 

tonisch (aanhoudend 

dichtklemmende 

samentrekkingen) of 

fasegewijs (herhaaldelijke 

korte samentrekkingen). 

Het algoritme gebruikt een EMG-

signaal van de kauwspieren en het 

activiteitssignaal. Perioden van tijdelijk 

verhoogde kauwspieractiviteit worden 

gevonden en gescoord als 

uitbarstingen. Als de gescoorde 

uitbarstingen binnen het patroon van 

tonische of fasegewijze bruxisme-

episodes passen, worden deze als 

zodanig gescoord zoals gedefinieerd 

door de AASM-richtlijnen. Standaard 

worden bruxisme-episodes genegeerd 

als deze samenvallen met 

patiëntbeweging, dit wordt 

gekenmerkt door een verhoging van 

het activiteitssignaal. 

Klinische gegevensset: De 

automatische analyse is gevalideerd 

voor klinische slaapregistraties van een 

algemene volwassenenpopulatie die 

medische hulp zocht in verband met 

slaapstoornissen. De slaapregistraties 

zijn van een score voorzien door een 

gecertificeerd technicus als onderdeel 

van standaard klinisch onderzoek. 

Primair veiligheidseindpunt: De 

analyse werd als veilig bevonden als 

het met 95% betrouwbaarheid ten 

minste 90% van de oromandibulaire 

bewegingen detecteerde die een 

menselijke deskundige beschouwde 

als bruxisme-voorvallen. 

Resultaat: De gevoeligheid van de 

analyse was 95,7% (95% CI 93,2% - 

97,4%), specificiteit was 61,0% (95% CI 

58,9% - 63,0%), PPV was 34,6% (95% CI 

32,0% - 37,3%), NPV was 98,5% (95% 

CI 97,7% - 99,1%). 

De bruxisme-analyse wordt daarom als 

veilig en effectief beschouwd. 
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Klinische aandoening Overzicht 

PLM-analyse 

Het klinische doel is het 

verbeteren van de 

effectiviteit van het scoren 

van voorvallen van 

periodieke 

ledemaatbewegingen.  

Beperkingen: Voordat een 

diagnose wordt gesteld 

moeten de resultaten van 

de automatische analyse 

altijd door een 

gecertificeerd technicus of 

een arts worden 

beoordeeld. 

Gescoorde indices:  

Limb Movement Index (LMI 

(ledemaatbewegingsindex)) 

- aantal 

ledemaatbewegingen per 

slaapuur 

Periodic Limb Movement 

Index (PLMS (periodieke 

ledemaatbewegingsindex)) - 

aantal periodieke 

ledemaatbewegingen per 

slaapuur 

Ledemaatbewegingen 

tijdens de slaap: Perioden, 

tijdens de slaap, die 0,5-10 

seconden duren, waarbij 

de spierspanning in een 

ledemaat, meestal 

gemeten in de tibialis-

spier, is verhoogd ten 

opzichte van de 

nulmeting. 

Periodieke 

ledemaatbeweging tijdens 

de slaap: Een periode 

tijdens de slaap met 

minimaal 4 

ledemaatbewegingsvoorva

llen met intervallen van 5 

tot 90 seconden. 

Het ledemaatbewegingsalgoritme 

maakt gebruik van EMG-signalen van 

het linker- en rechterbeen om 

perioden te identificeren waarin de 

spierspanning is verhoogd. Daarnaast 

wordt het activiteitssignaal gebruikt 

voor het detecteren van 

patiëntactiviteit. 

De PLM-analyse lokaliseert voorvallen 

van hoge spieractiviteit of kinetische 

activiteit en identificeert deze als 

voorvallen (van ledemaatbeweging). 

Deze worden vervolgens gebruikt om 

vast te stellen of er PLM-voorvallen 

(voorvallen van periodieke 

ledemaatbeweging) aanwezig zijn. De 

analyse volgt de richtlijnen die door de 

AASM zijn uiteengezet. 

Klinische gegevensset: De 

automatische analyse is gevalideerd 

voor klinische slaapregistraties van een 

algemene volwassenenpopulatie die 

medische hulp zocht in verband met 

slaapstoornissen. De slaapregistraties 

zijn van een score voorzien door een 

gecertificeerd technicus als onderdeel 

van standaard klinisch onderzoek. 

Primair veiligheidseindpunt: De 

analyse werd veilig bevonden op basis 

van de veiligheidshypothese dat aan 

alle onderstaande criteria is voldaan 

voor de PLMI-index. 

• Correlatie tussen klassen 

(ICC, interclass correlation) 

moet groter zijn dan 0,61 

• Pearson correlatie-coëfficiënt 

(PCC) moet gelijk zijn aan of 

groter zijn dan r = 0,65 

• De absolute bias mag niet 

groter zijn dan 5,7 
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Klinische aandoening Overzicht 

Resultaat: ICC is 0,98, Pearson 

correlatie-coëfficiënt is 0,94 en 

absolute bias is 0,29 voor de index van 

periodieke ledemaatbeweging 

De PLM-analyse wordt daarom als 

veilig en effectief beschouwd. 

Analyse van de 

ademhalingsstroom 

(gekalibreerde RIP, canule)1 

1) Het klinische doel is het 

verbeteren van de 

effectiviteit van het scoren 

van apneus, hypopneus 

(door middel van de 

gekalibreerde RIP, canule) 

en desaturatievoorvallen 

van de oximeter.  

Beperkingen: Voordat een 

diagnose wordt gesteld 

moeten de resultaten altijd 

door een gecertificeerd 

technicus of een arts 

worden beoordeeld. 

Gescoorde indices: 

Apnea Hypopnea Index (AHI 

(apneu hypopneu-index)) - 

aantal apneus en 

hypopneus per slaapuur 

Apneus tijdens de slaap: 

Perioden van langer dan 

10 seconden waarin een 

patiënt stopt met 

ademhalen. 

Hypopneus tijdens de 

slaap: Perioden van langer 

dan 10 seconden waarin 

een patiënt significant 

minder ademhaalt. 

Zuurstofdesaturatie 

tijdens de slaap: Perioden 

waarbij de 

zuurstofsaturatie van het 

arteriële bloed van een 

patiënt meer dan 3% 

onder de nulmeting komt. 

Centrale apneus tijdens de 

slaap: Perioden van 10 

seconden of langer 

waarbij een patiënt stopt 

met ademen en er geen 

ademhalingsinspanning is. 

Gemengde apneus tijdens 

de slaap: Perioden van 10 

seconden of langer 

1) Het Apneu/Hypopneu-algoritme 

(AHI-algoritme) gebruikt, waar van 

toepassing, het signaal van de 

ademhalingscanulestroom of van de 

gekalibreerde RIP-stroom van de 

ademhaling, afhankelijk van de 

analyse-uitvoering. Het algoritme kan 

gescoorde voorvallen in de EEG 

gebruiken voor het toekennen van een 

score aan hypopneus. De gescoorde 

EEG-voorvallen zijn arousals tijdens de 

slaap waaraan handmatig scores zijn 

toegekend. Het algoritme gebruikt ook 

een SpO2-signaal, gemeten door een 

oximeter, voor het vinden van 

desaturatievoorvallen die worden 

gebruikt voor toekennen van scores 

aan hypopneus. Het algoritme kent 

echter geen scores toe aan de 

desaturatievoorvallen.  

Het AHI-algoritme bepaalt of een 

patiënt normaal ademt, of de 

ademhaling significant is verminderd, 

resulterend in een hypopneu of dat 

een patiënt niet ademhaalt, 

resulterend in een apneu. Als de 

ademhaling significant is verminderd, 

controleert het algoritme voor het 

 

1 Inclusief de AHI- en ODI-algoritmes en het Apneuclassificatie-algoritme 
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Apnea Index (AI (apneu-

index)) - aantal apneus per 

slaapuur 

Hypopnea Index (HI 

(hypopneu-index)) - aantal 

hypopneus per slaapuur 

Oxygen Desaturation Index 

(ODI (zuurstofdesaturatie-

index)) - aantal voorvallen 

van zuurstofdesaturatie per 

slaapuur. 

2) Het klinische doel is het 

verbeteren van de 

effectiviteit van het 

classificeren van apneus in 

centrale apneus, gemengde 

apneus of geen van beide.  

Beperkingen: Voordat een 

diagnose wordt gesteld 

moeten de resultaten altijd 

door een gecertificeerd 

technicus of een arts 

worden beoordeeld. 

Gescoorde indices: 

Central Apnea Index (CAI 

(centrale apneu-index)) - 

aantal centrale apneus en 

hypopneus per slaapuur 

Mixed Apnea Index (MAI 

(gemengde apneu-index)) - 

aantal gemengde apneus 

per slaapuur 

Central Mixed Apnea Index 

(CMAI (centrale gemengde 

apneu-index)) - aantal 

centrale en gemengde 

apneus per slaapuur 

 

waarbij een patiënt stopt 

met ademen. 

Ademhalingsinspanning is 

afwezig aan het begin van 

de periode, maar 

aanwezig aan het einde 

van de periode. 

 

toekennen van een score aan een 

hypopneu of er een arousal is of een 

daling in het zuurstofgehalte van het 

bloed die verband houdt met de 

verminderde ademhaling. 

Het Desaturatie-algoritme (ODI-

algoritme) gebruikt een SpO2-signaal 

dat gemeten wordt door een oximeter, 

om vast te stellen of er een daling van 

3% of meer is in het zuurstofgehalte 

van het bloed. 

De analyse volgt de richtlijnen die door 

de AASM zijn uiteengezet. 

2) Het Apnea Classification-algoritme 

(apneuclassificatie-algoritme) gebruikt 

een ademhalingsstroomsignaal en 

daarnaast ook de Respiratory 

Inductance Plethysmography-signalen 

(RIP-signalen (ademhalingsinductantie-

plethysmografie-signalen)) van de buik 

en de thorax. 

Het Apneuclassificatie-algoritme 

classificeert de apneus die van een 

score zijn voorzien als centraal of 

gemengd als de 

ademhalingsinspanning afwezig is 

tijdens de apneu, of als geen van 

beide. 

De analyse volgt de richtlijnen die door 

de AASM zijn uiteengezet. 

Klinische gegevensset: De 

automatische analyses zijn gevalideerd 

voor klinische slaapregistraties van een 

algemene volwassenenpopulatie die 

medische hulp zocht in verband met 

slaapstoornissen. De slaapregistraties 

werden van een score voorzien door 

een gecertificeerd technicus als 

onderdeel van standaard klinisch 

onderzoek.  
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Primaire veiligheidseindpunten:  

1) De automatische analyse van de 

ademhalingsstroom werd als veilig 

beschouwd als het met 95% 

betrouwbaarheid patiënten met een 

AHI onder de 5 niet classificeerde als 

een AHI groter of gelijk aan 15 of als 

het met 95% betrouwbaarheid 

patiënten met een AHI groter of gelijk 

aan 15 niet classificeerde als een AHI 

onder de 5. 

Er zijn twee mede-primaire 

eindpunten voor AHI gebruikt.  

a) Cohen's Kappa moet gelijk zijn 

aan of groter zijn dan 0,66 en 

de Pearson-correlatie moet 

gelijk zijn aan of groter zijn 

dan r = 0,96 voor de canule.  

b) Cohen's Kappa van 0,66 moet 

binnen het 

betrouwbaarheidsinterval van 

95% zijn en Pearson-correlatie 

moet gelijk zijn aan of groter 

zijn dan r = 0,72 voor de cRIP. 

Het criterium voor ODI is dat de 

correlatie binnen de klassen (Intra-

Class Correlation, ICC) gelijk is aan of 

groter is dan 0,93. 

2) De automatische analyse van 

apneuclassificatie werd als veilig 

beschouwd als het voldeed aan de 

acceptatiecriteria van een ICC die 

vergelijkbaar is met dat waarover 

wordt gerapporteerd in de 

wetenschappelijke literatuur over de 

centrale apneu-index (Central Apnea 

Index, CAI 0,46). 

Resultaat:  

1) De analyse is veilig aangezien de 

kans op onjuiste classificatie tussen de 
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verschillende groepen minder dan de 

geaccepteerde 5% is.  

a) Cohen's Kappa is 0,78 en 

Pearson's r = 0,96 voor de 

canule.  

b) Cohen's Kappa is 0,62 (95% CI 

0,56 – 0,66) en Pearson's r = 

0,79 voor de cRIP.  

De ICC voor ODI was 0,95.  

2) De ICC was 0,91 voor de centrale 

apneu-index. 

De respiratoire flowanalyse wordt 

daarom als veilig en effectief 

beschouwd. 

Analyse van slaapstadiëring 

Het klinische doel is het 

verbeteren van de 

effectiviteit van het 

toekennen van scores aan 

slaapstadia om zo de totale 

slaapduur te schatten.   

Beperkingen: Voordat een 

diagnose wordt gesteld 

moeten de resultaten van 

de automatische analyse 

altijd door een 

gecertificeerd technicus of 

een arts worden 

beoordeeld. 

De volgende voorvallen 

worden van scores voorzien: 

Slaapstadium W (wakker), 

stadium N1, stadium N2, 

stadium N3 en stadium R 

(REM). 

 

Het patroon van de 

slaapstadia wordt gebruikt 

om te analyseren hoe 

iemand slaapt en wordt 

gebruikt voor het bepalen 

van afwijkingen in het 

slaapprofiel die kunnen 

duiden op 

slaapstoornissen.  

Het algoritme maakt gebruik van 

elektro-encefalografiesignalen (EEG-

signalen), elektro-oculogramsignalen 

(EOG-signalen) voor het voorscoren 

van slaapstadia volgens de handleiding 

van de AASM.  

Het algoritme is geïmplementeerd in 

een kunstmatig neuraal netwerk. De 

geregistreerde ruwe EEG- en EOG-

signalen worden ingevoerd in het 

kunstmatige neurale netwerk, dat 

slaapfasen voor epochen van 30 

seconden terugstuurt, om te simuleren 

hoe menselijke scorers slaapfasen 

scoren. 

Klinische gegevensset: De 

automatische analyse is gevalideerd 

voor klinische slaapregistraties van een 

algemene volwassenenpopulatie. De 

slaapregistraties zijn van een score 

voorzien door een gecertificeerd 

technicus. 

Primair veiligheidseindpunt: De 

analyse werd veilig bevonden als 

gemiddeld 60% van de scores van de 
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wakker-tijdvakken overeenkwamen. 

Mede-primair eindpunt is dat Cohen's 

Kappa-statistieken gelijk zijn aan of 

groter zijn dan 0,63. 

Resultaten: De Cohen's Kappa werd 

berekend als κ = 0,76. De gemiddelde 

overeenstemming voor de waakscore 

was 78,3%. De nauwkeurigheid van het 

voorspellen van slaapstadia 

resulteerde in N1 (54,4%), N2 (84,4%), 

N3 (84,8%), Wakker (78,3%) en REM 

(88,2%). De Slaapfase Analyse wordt 

daarom als veilig en effectief 

beschouwd. 

Arousal-analyse 

Het klinische doel is het 

verbeteren van de 

effectiviteit van het 

toekennen van scores aan 

arousals om zo het 

toekennen van scores aan 

hypopneus te verbeteren. 

Beperkingen: Voordat een 

diagnose wordt gesteld 

moeten de resultaten van 

de automatische analyse 

altijd door een 

gecertificeerd technicus of 

een arts worden 

beoordeeld. 

De volgende voorvallen 

worden van scores voorzien: 

Arousals gedetecteerd in de 

EEG-signalen. 

Arousals tijdens de slaap: 

Plotselinge verandering in 

de EEG-frequentie die 3 

tot 10 seconden duurt na 

10 seconden van stabiele 

slaap. De resulterende 

arousal-index wordt 

gebruikt voor het 

detecteren van 

afwijkingen in het 

slaapprofiel die kunnen 

duiden op 

slaapstoornissen. Er wordt 

rekening gehouden met 

arousals bij het detecteren 

van hypopneus en ze zijn 

daarom gerelateerd aan 

de apneu-hypopneu-index 

(AHI). 

Het algoritme maakt gebruik van 

elektro-encefalografiesignalen (EEG-

signalen), elektro-oculogramsignalen 

(EOG-signalen) voor het voorscoren 

van arousals volgens de handleiding 

van de AASM.  

Het algoritme is geïmplementeerd in 

een kunstmatig neuraal netwerk. De 

geregistreerde ruwe EEG-, EOG- en 

EMG-signalen worden ingevoerd in het 

kunstmatige neurale netwerk, dat 

gebeurtenissen terugstuurt waar de 

arousals optreden om te simuleren 

hoe mensen arousals scoren. 

Klinische gegevensset: De 

automatische analyse is gevalideerd 

voor klinische slaapregistraties van een 

algemene volwassenenpopulatie. De 

slaapregistraties zijn van een score 

voorzien door een gecertificeerd 

technicus. 

Primair veiligheidseindpunt: De 

analyse werd als veilig en effectief 

beschouwd als deze voldeed aan het 

eindpunt van een positieve 

overeenstemming (PA) van minimaal 

60%, een PA-ondergrens van 95%-
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betrouwbaarheidsinterval van 55%, 

een negatieve overeenstemming (NA) 

van 90% en een NA-ondergrens van 

95%-betrouwbaarheidsinterval van 

88% in epochen gescoord met een 

arousal of zonder een arousal. 

Resultaten: Een totaal aantal van 

30900 epochen werd gescoord als al 

dan niet een arousal bevattend. De 

resultaten waren een PA = 67,67 (95% 

CI 62,19 – 72,80) en een NA = 97,51 

(95% CI 96,79 – 98,16). De arousal-

analyse wordt daarom als veilig en 

effectief beschouwd. 

Nox BodySleep-analyse 

Het klinische doel is het 

verkrijgen van een 

nauwkeuriger schatting van 

de slaapduur tijdens een 

thuisslaaponderzoek door 

het juist classificeren van 

het wakker-stadium in een 

thuisslaaponderzoek. 

Beperkingen: Voordat een 

diagnose wordt gesteld 

moeten de resultaten van 

de automatische analyse 

altijd door een 

gecertificeerd technicus of 

een arts worden 

beoordeeld. 

De volgende voorvallen 

worden van scores voorzien: 

Slaapstadium Wakker, 

slaapstadium NREM en 

slaapstadium REM. 

De slaapduur wordt 

gebruikt als metriek bij het 

berekenen van AHI 

(apneu-hypopneu-index) 

tijdens de slaap en kan 

ook worden gebruikt voor 

het beoordelen van 

slaapduur voor het 

vaststellen van afwijkingen 

in het slaapprofiel die 

kunnen duiden op 

slaapstoornissen. 

De "Nox BodySleep" is een methode 

van kunstmatige intelligentie (AI, 

artificial intelligence) waarmee 

tijdvakken van 30 seconden kunnen 

worden geclassificeerd in de stadia 

REM-slaap, NREM-slaap en Wakker. 

Het maakt gebruik van de 

ademhalingsinductantie-

plethysmografie-signalen (RIP-

signalen) en actigrafie voor het meten 

van de invloed van verandering in de 

staat van de hersenen op het lichaam. 

Het gebruikt deze signalen voor het 

inschatten van de slaapstadia. 

Klinische gegevensset: Analyse 

achteraf van 

polysomnografiegegevens die zijn 

verzameld met het Nox-slaapsysteem 

van patiënten die een standaard 

klinisch slaaponderzoek ondergaan 

wegens een vermoedelijke 

slaapstoornis. De slaapregistraties zijn 

van een score voorzien door een 

gecertificeerd technicus als onderdeel 

van standaard klinisch onderzoek. 

Primaire veiligheidseindpunten: Het 

gekozen primaire eindpunt is de 
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algehele overeenkomst in het 

classificeren van slaap- en waakstadia, 

die resulteert uit de vergelijking tussen 

handmatige scoretoekenning en 

automatische scoretoekenning door 

de analyse. Het eindpunt wordt als 

succesvol beschouwd als de algemene 

overeenstemming van de slaap-

waakclassificatie statistisch significant 

meer dan 76% bedraagt. Een secundair 

onderzoekseindpunt is de 

overeenkomst tussen handmatige 

scoretoekenning en automatische 

scoretoekenning zoals beoordeeld met 

Cohen's Kappa (κ). Het eindpunt wordt 

beschouwd als succesvol als κ > 0,50.  

Resultaten: De algehele 

overeenstemming was 85,6% (95% BI 

83,4% - 87,6%) en overtrof de 

acceptatiecriteria van 76%. 

De Cohen's kappa van de analyse was 

0,62 (95% BI 0,58 - 0,66) en overtrof 

de criteria van 0,5. 

De Nox BodySleep Analyse wordt 

daarom als veilig en effectief 

beschouwd. 

Analyse van SAS -

slaapstadiëring 

Het klinische doel is het 

verbeteren van de 

effectiviteit van het 

toekennen van scores aan 

slaapstadia om zo de totale 

slaapduur te schatten.   

Beperkingen: Voordat een 

diagnose wordt gesteld 

moeten de resultaten van 

de automatische analyse 

altijd door een 

gecertificeerd technicus of 

Het patroon van de 

slaapstadia wordt gebruikt 

om te analyseren hoe 

iemand slaapt en wordt 

gebruikt voor het bepalen 

van afwijkingen in het 

slaapprofiel die kunnen 

duiden op 

slaapstoornissen.  

Het algoritme maakt gebruik van 

elektro-encefalografiesignalen (EEG-

signalen), elektro-oculogramsignalen 

(EOG-signalen) en EMG-signalen 

(frontalis-elektromyografie) om de 

score van slaapfasen vooraf te 

berekenen volgens de AASM-

handleiding. 

Het algoritme is geïmplementeerd in 

een kunstmatig neuraal netwerk. De 

geregistreerde ruwe EEG- en EOG-

signalen worden ingevoerd in het 

kunstmatige neurale netwerk, dat 

slaapfasen voor epochen van 30 

seconden terugstuurt, om te simuleren 
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een arts worden 

beoordeeld. 

De volgende voorvallen 

worden van scores voorzien: 

Slaapstadium W (wakker), 

stadium N1, stadium N2, 

stadium N3 en stadium R 

(REM). 

 

hoe menselijke scorers slaapfasen 

scoren. 

Klinische gegevensset: De 

automatische analyse is gevalideerd 

voor klinische slaapregistraties van een 

algemene volwassenenpopulatie. De 

slaapregistraties zijn van een score 

voorzien door een gecertificeerd 

technicus. 

Primair veiligheidseindpunt: De 

analyse werd veilig bevonden als 

gemiddeld 60% van de scores van de 

wakker-tijdvakken overeenkwamen. 

Mede-primair eindpunt is dat Cohen's 

Kappa-statistieken gelijk zijn aan of 

groter zijn dan 0,63. 

Resultaten: De Cohen's Kappa werd 

berekend als κ = 0,69. De gemiddelde 

overeenstemming voor de waakscore 

was 75,8%. De nauwkeurigheid van het 

voorspellen van slaapstadia 

resulteerde in N1 (65,8%), N2 (85,3%), 

N3 (80,3%), Wakker (75,8%) en REM 

(86,1%). De SAS-Slaapfase Analyse 

wordt daarom als veilig en effectief 

beschouwd. 

SAS Arousal-analyse 

Het klinische doel is het 

verbeteren van de 

effectiviteit van het 

toekennen van scores aan 

arousals om zo het 

toekennen van scores aan 

hypopneus te verbeteren. 

Beperkingen: Voordat een 

diagnose wordt gesteld 

moeten de resultaten van 

de automatische analyse 

altijd door een 

gecertificeerd technicus of 

Arousals tijdens de slaap: 

Plotselinge verandering in 

de EEG-frequentie die 3 

tot 10 seconden duurt na 

10 seconden van stabiele 

slaap. De resulterende 

arousal-index wordt 

gebruikt voor het 

detecteren van 

afwijkingen in het 

slaapprofiel die kunnen 

duiden op 

slaapstoornissen. Er wordt 

rekening gehouden met 

arousals bij het detecteren 

Het algoritme maakt gebruik van EEG-

signalen (elektro-encefalografie), EOG-

signalen (elektro-oculografie) en EMG-

signalen (frontalis-elektromyografie) 

om de score van arousals vooraf te 

berekenen volgens de AASM-

handleiding.  

Het algoritme is geïmplementeerd in 

een kunstmatig neuraal netwerk. De 

geregistreerde ruwe EEG-, EOG- en 

EMG-signalen worden ingevoerd in het 

kunstmatige neurale netwerk, dat 

gebeurtenissen terugstuurt waar de 
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een arts worden 

beoordeeld. 

De volgende voorvallen 

worden van scores voorzien: 

Arousals gedetecteerd in de 

EEG-signalen. 

van hypopneus en ze zijn 

daarom gerelateerd aan 

de apneu-hypopneu-index 

(AHI). 

arousals optreden om te simuleren 

hoe mensen arousals scoren. 

Klinische gegevensset: De 

automatische analyse is gevalideerd 

voor klinische slaapregistraties van een 

algemene volwassenenpopulatie. De 

slaapregistraties zijn van een score 

voorzien door een gecertificeerd 

technicus. 

Primair veiligheidseindpunt: De 

analyse werd als veilig en effectief 

beschouwd als deze voldeed aan het 

eindpunt van een positieve 

overeenstemming (PA) van minimaal 

60%, een PA-ondergrens van 95%-

betrouwbaarheidsinterval van 55%, 

een negatieve overeenstemming (NA) 

van 90% en een NA-ondergrens van 

95%-betrouwbaarheidsinterval van 

88% in epochen gescoord met een 

arousal of zonder een arousal. 

Resultaten: Een totaal aantal van 

70349 epochen werd gescoord als al 

dan niet een arousal bevattend. De 

resultaten waren een PA = 68,10 (95% 

CI 65,52 – 70,64) en een NA = 94,48 

(95% CI 93,33 – 95,46). De SAS-analyse 

van arousals wordt daarom als veilig 

en effectief beschouwd 

 


